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Introduction to the KiCad Schematic Editor
Deskripsi
The KiCad Schematic Editor is a schematic capture software distributed as a part of KiCad and available
under the following operating systems:

Linux

Apple macOS

Windows

Regardless of the OS, all KiCad files are 100% compatible from one OS to another.

The Schematic Editor is an integrated application where all functions of drawing, control, layout, library
management and access to the PCB design software are carried out within the editor itself.

The KiCad Schematic Editor is intended to cooperate with the KiCad PCB Editor, which is KiCad’s printed
circuit design software. It can also export netlist files, which lists all the electrical connections, for other
packages.

The Schematic Editor includes a symbol library editor, which can create and edit symbols and manage
libraries. It also integrates the following additional but essential functions needed for modern schematic
capture software:

Electrical rules check (ERC), sebagai kontrol otomatis untuk koneksi yang hilang atau tidak tepat

Ekspor berkas-berkas plot dalam berbagai format (Postscript, PDF, HPGL, dan SVG)

Pembuatan daftar komponen (Bill of Materials), melalui skrip Python atau XSLT, yang mampu menangani
berbagai format fleksibel.

Tinjauan Teknis
The Schematic Editor is limited only by the available memory. There is thus no real limitation to the number
of components, component pins, connections or sheets. In the case of multi-sheet schematics, the
representation is hierarchical.

The Schematic Editor can use multi-sheet schematics in a few ways:

Hirarki sederhana (setiap skematik hanya digunakan satu kali saja).

Hirarki kompleks (beberapa skematik digunakan lebih dari sekali dan dapat dimunculkan beberapa
kali).

Hirarki datar (skematik tidak terhubung secara eksplisit di dalam diagram utama).
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Generic Schematic Editor commands
Perintah-perintah yang ada di Eeschema dapat dijalankan dengan cara:

Klik pada bilah menu (di bagian atas layar).

Klik pada ikon di bagian atas layar (untuk perintah-perintah umum).

Klik pada ikon di bagian kanan layar (untuk perintah atau "peralatan" khusus).

Klik pada ikon di bagian kiri layar (untuk berbagai opsi tampilan).

Menekan tombol tetikus (untuk perintah-perintah tambahan yang penting). Secara khusus, klik kanan
pada tetikus akan membuka sebuah menu kontekstual untuk elemen yang berada di bawah kursor
(Perbesar atau perkecil, pengaturan grid, dan pengeditan elemen).

Function keys ( , , , ,  and ). Specifically:  cancels the command in
progress.  allows the duplication of the last element created.

Pressing hotkeys. For a list of hotkeys, see the Help→List Hotkeys menu entry or press + . Many
hotkeys select a tool but do not perform the tool’s action until the canvas is clicked. This behavior can be
changed by unchecking First hotkey selects tool in the Common Preferences pane. With this option
unchecked, pressing a hotkey will select the tool and immediately perform the tool’s action at the current
cursor location.

F1 F2 F3 F4 Insert Space Escape

Insert

Ctrl F1
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Perintah-perintah Tetikus

Perintah-perintah Dasar
Tombol kiri

Single click: Selects the item under the cursor and displays the item’s characteristics in the status bar.

Double click: edits the item if it is editable.

Tombol kanan

Opens a pop-up menu. If an item is selected, the items in the menu are related to the selected item. If an
item is under the cursor when the right mouse button is clicked, the item is selected.

Selection operations
Schematic editor items can be selected by clicking on them. Multiple items can be selected at once. Add items
to the selection with  + click, and remove items from the selection with +  + click.

NOTE On macOS,  is used instead of .

left mouse button Select item.

 + left mouse button Add item to selection.

+  + left mouse button Remove item from
selection.

 + left mouse button Highlight net.

Items can also be selected by drawing a box around them using the left mouse button.

Dragging from left to right includes all items fully enclosed by the box. Dragging from right to left includes
all items touched by the box, even if they are not fully enclosed.

The  and +  modifiers also work with drag selections to add and remove items from the
selection, respectively.

Tombol Hotkey
The +  displays the current hotkey list.

All hotkeys can be redefined using the hotkey editor (Preferences → Preferences…  → Hotkeys).

The default hotkey list is below. Many additional actions do not have hotkeys by default, but hotkeys can be
assigned to them with the hotkey editor.

Action Default
Hotkey

Description

Click Performs left mouse button click

Shift Ctrl Shift

Cmd Ctrl

Shift

Ctrl Shift

Ctrl

Shift Ctrl Shift

Ctrl F1

Return
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Action Default
Hotkey

Description

Double-click Performs left mouse button double-click

Cursor Down

Cursor Down Fast +

Cursor Left

Cursor Left Fast +

Cursor Right

Cursor Right Fast +

Cursor Up

Cursor Up Fast +

Switch to Fast Grid
1

+

Switch to Fast Grid
2

+

Switch to Next
Grid

Switch to Previous
Grid

+

Reset Grid Origin

Grid Origin Set the grid origin point

New… + Create a new document in the editor

Open… + Open existing document

Pan Down +

Pan Left +

Pan Right +

Pan Up +

Print… + Print

Reset Local
Coordinates

Save + Save changes

End

Down

Ctrl Down

Left

Ctrl Left

Right

Ctrl Right

Up

Ctrl Up

Alt 1

Alt 2

N

Shift N

Z

S

Ctrl N

Ctrl O

Shift Down

Shift Left

Shift Right

Shift Up

Ctrl P

Space

Ctrl S
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Action Default
Hotkey

Description

Center Center

Zoom to Objects + Zoom to Objects

Zoom to Fit Zoom to Fit

Zoom In at Cursor Zoom In at Cursor

Zoom Out at
Cursor

Zoom Out at Cursor

Refresh Refresh

Zoom to Selection + Zoom to Selection

Change Edit
Method

+ Change edit method constraints

Copy + Copy selected item(s) to clipboard

Cut + Cut selected item(s) to clipboard

Delete Deletes selected item(s)

Duplicate + Duplicates the selected item(s)

Find + Find text

Find and Replace + + Find and replace text

Find Next Find next match

Find Next Marker +

Paste + Paste item(s) from clipboard

Redo + Redo last edit

Select All + Select all items on screen

Undo + Undo last edit

List Hotkeys… + Displays current hotkeys table and corresponding commands

Preferences… + Show preferences for all open tools

Clear Net
Highlighting

Clear any existing net highlighting

Edit Library
Symbol… 

+ + Open the library symbol in the Symbol Editor

F4

Ctrl Home

Home

F1

F2

F5

Ctrl F5

Ctrl Space

Ctrl C

Ctrl X

Del

Ctrl D

Ctrl F

Ctrl Alt

F

F3

Shift F3

Ctrl V

Ctrl Y

Ctrl A

Ctrl Z

Ctrl F1

Ctrl ,

~

Ctrl Shift

E
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Action Default
Hotkey

Description

Add Sheet Add a hierarchical sheet

Add Wire to Bus
Entry

Add a wire entry to a bus

Add Global Label + Add a global label

Add Hierarchical
Label

Add a hierarchical label

Add Junction Add a junction

Add Label Add a net label

Add No Connect
Flag

Add a no-connection flag

Add Power Add a power port

Add Text Add text

Add Symbol Add a symbol

Add Bus Add a bus

Add Lines Add connected graphic lines

Add Wire Add a wire

Finish Wire or Bus Complete drawing at current segment

Unfold from Bus Break a wire out of a bus

Autoplace Fields Runs the automatic placement algorithm on the symbol or sheet’s
fields

Edit Footprint… Displays footprint field dialog

Edit Reference
Designator… 

Displays reference designator dialog

Edit Value… Displays value field dialog

Mirror
Horizontally

Flips selected item(s) from left to right

Mirror Vertically Flips selected item(s) from top to bottom

Properties… Displays item properties dialog

Repeat Last Item Duplicates the last drawn item

S

Z

Ctrl L

H

J

L

Q

P

T

A

B

I

W

K

C

O

F

U

V

X

Y

E

Ins
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Action Default
Hotkey

Description

Select Node + Select a connection item under the cursor

Leave Sheet + Display the parent sheet in the schematic editor

Hotkeys are stored in the file user.hotkeys  in KiCad’s configuration directory. The location is platform-
specific:

Windows: %APPDATA%\kicad\6.0\user.hotkeys

Linux: ~/.config/kicad/6.0/user.hotkeys

macOS: ~/Library/Preferences/kicad/6.0/user.hotkeys

It is possible to import hotkey settings from a user.hotkeys  file using menu Preferences→Preferences… 
→Hotkeys→Import Hotkeys… .

Grid
In the Schematic Editor the cursor always moves over a grid. The grid can be customized:

Size can be changed using the right click menu or using View → Grid Properties… .

Color can be changed in the Colors page of the Preferences dialog (menu Preferences → General
Options).

Visibility can be switched using the left-hand toolbar button.

The default grid size is 50 mil (0.050") or 1.27 millimeters.

Ukuran tersebut adalah ukuran yang direkomendasikan untuk meletakkan simbol dan wire di skematik, dan
untuk meletakkan pin pada saat mendesain sebuah simbol di Symbol Editor.

Kita juga bisa menggunakan ukuran grid yang lebih kecil, dari 25 mil hingga 10 mil. Ukuran ini hanya
dimaksudkan untuk digunakan pada saat mendesain bentuk simbol atau meletakkan teks dan komentar,
dan tidak direkomendasikan untuk digunakan pada saat meletakkan pin dan wire.

Pilihan Perbesaran/perkecilan
Untuk mengubah tingkat perbesaran/perkecilan:

Klik kanan untuk membuka menu pop-up dan pilih tingkat perbesaran/perkecilan yang diinginkan.

Or use hotkeys:

: Zoom in

: Zoom out

: Center the view around the cursor pointer position

: Zoom and center the view to fit the entire schematic sheet

+ : Zoom and center the view to fit all of the objects in the schematic

+ : Activate the Zoom to Selection tool

Alt 3

Alt Back

F1

F2

F4

Home

Ctrl Home

Ctrl F5
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Mouse wheel: Zoom in/out

Shift+Mouse wheel: Pan up/down

Ctrl+Mouse wheel: Pan left/right

Mouse scroll gestures are configurable in the Mouse and Touchpad page of the Preferences dialog.

Menampilkan Koordinat Kursor
The display units are in inches, mils, or millimeters.

Informasi berikut ini ditampilkan pada bagian kanan bawah jendela:

Faktor perbesaran/perkecilan

Posisi absolut kursor

Posisi relatif kursor

The grid size

The active unit system

The active tool

Koordinat relatif dapat direset menjadi nol dengan menekan Spasi. Hal ini berguna untuk mengukur jarak
antara dua titik atau untuk meluruskan suatu obyek.

Bilah Menu Atas
bilah menu atas digunakan untuk membuka dan menyimpan skematik, konfigurasi program, dan untuk
melihat dokumentasi.

Bilah Alat Bagian Atas
This toolbar gives access to the main functions of the Schematic Editor.

If the Schematic Editor is run in standalone mode, this is the available tool set:

Jika KiCad dijalankan pada mode proyek, maka dua ikon pertama di atas tidak tersedia, karena ikon
tersebut hanya bekerja dengan berkas-berkas individual.

Create a new schematic (only in standalone mode).

Open a schematic (only in standalone mode).

Save complete schematic project.

Set the schematic-specific options.
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Select the sheet size and edit the title block.

Open print dialog.

Open plot dialog.

Paste a copied/cut item or block to the current sheet.

Undo: Revert the last change.

Redo: Revert the last undo operation.

Show the dialog to search symbols and texts in the schematic.

Show the dialog to search and replace texts in the schematic.

Refresh screen.

Zoom in.

Zoom out.

Zoom to fit the entire schematic sheet.

Zoom to fit all objects in the schematic.

Zoom to fit selected items.

View and navigate the hierarchy tree.

Leave the current sheet and go up in the hierarchy.

Rotate selected items counter-clockwise.

Rotate selected items clockwise.

Mirror selected items vertically.

Mirror selected items horizontally.

Call the symbol library editor to view and modify libraries and symbols.

Browse symbol libraries.

Open the footprint library editor to view and modify libraries and footprints.

Annotate symbols.

Electrical Rules Checker (ERC), automatically validate electrical connections.
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Open the footprint assignment tool to assign footprints to symbols.

Bulk edit symbol fields in a spreadsheet interface.

Generate the Bill of Materials (BOM).

Open the PCB editor.

Open the Python scripting console.

Bilah Alat Bagian Kanan
Bilah alat ini berisi berbagai alat untuk:

Meletakkan simbol, wire, bus, junction, label, teks, dsb.

Membuat lembar kerja hirarkis dan simbol-simbol koneksi.
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Cancel the active command or tool and go into selection mode.

Highlight a net by marking its wires and net labels with a different color. If the PCB Editor is
also open then copper corresponding to the selected net will be highlighted as well.

Display the symbol selector dialog to select a new symbol to be placed.

Display the power symbol selector dialog to select a power symbol to be placed.

Draw a wire.

Draw a bus.

Draw wire-to-bus entry points. These elements are only graphical and do not create a
connection, thus they should not be used to connect wires together.

Place a "No Connect" flag. These flags should be placed on symbol pins which are meant to be
left unconnected. It is done to notify the Electrical Rules Checker that lack of connection for a
particular pin is intentional and should not be reported.

Place a junction. This connects two crossing wires or a wire and a pin, when it can be
ambiguous (i.e. if a wire end or a pin is not directly connected to another wire end).

Place a local label. Local label connects items located in the same sheet. For connections
between two different sheets, you have to use global or hierarchical labels.

Place a global label. All global labels with the same name are connected, even when located on
different sheets.

Place a hierarchical label. Hierarchical labels are used to create a connection between a
subsheet and the parent sheet that contains it.

Place a hierarchical subsheet. You must specify the file name for this subsheet.

Import a hierarchical pin from a subsheet. This command can be executed only on hierarchical
subsheets. It will create hierarchical pins corresponding to hierarchical labels placed in the
target subsheet.

Draw a line. These are only graphical and do not connect anything.

Place a text comment.

Place a bitmap image.

Delete clicked items.

Bilah Alat Sebelah Kiri
Bilah alat ini berfungsi untuk melakukan pengaturan tampilan:
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Toggle grid visibility.

Switch units to inches.

Switch units to mils (0.001 inches).

Switch units to millimeters.

Choose the cursor shape (full screen/small).

Toggle visibility of "invisible" pins.

Toggle free angle/90 degrees wires and buses placement.

Menu Pop-up dan Pengeditan Cepat
Klik kanan tetikus akan membuka sebuah menu kontekstual untuk elemen yang dipilih. Menu tersebut
berisi:

Faktor perbesaran/perkecilan.

Pengaturan grid.

Copy/Paste/Delete commands.

Add Wire/Bus.

Parameter-parameter yang sering diedit untuk elemen yang dipilih.
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Menu Utama
Menu File
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New Close current schematic and start a new one (only in standalone
mode).

Open Load a schematic project (only in standalone mode).

Open Recent Open a schematic project from the list of recently opened files (only in
standalone mode).

Save Save current sheet and all its subsheets.

Save As… Save the current sheet under a new name (only in standalone mode).

Save Current Sheet Copy As… Save a copy of the current sheet under a new name (only in project
mode).

Insert Schematic Sheet
Content… 

Insert the contents of another schematic sheet into the current sheet
(only in standalone mode).

Import Import a non-KiCad schematic or a footprint assignment file.

Export Export a netlist or a drawing of the schematic to the clipboard.

Schematic Setup… Set up schematic formatting, electrical rules, net classes, and text
variables.

Page Settings… Configure page dimensions and title block.

Print Print schematic project (See also chapter Plot and Print).

Plot Export to PDF, PostScript, HPGL or SVG format (See chapter Plot and
Print).

Quit Terminate the application.

Schematic Setup
The Schematic Setup window is used to set schematic options that are specific to the currently active
schematic. For example, the Schematic Setup window contains formatting options, electrical rule
configuration, netclass setup, and schematic text variable setup.
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Menu Preferences

Configure Paths… Set the default search paths.

Manage Symbol Library
Tables… 

Add/remove symbol libraries.

Preferences… Preferences (units, grid size, field names, etc.).

Set Language Select interface language.
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Mengelola Tabel Pustaka Simbol

KiCad uses two library tables to store the list of available symbol libraries, which differ by the scope:

Pustaka Global
Libraries listed in the Global Library table are available to every project. They are saved in the sym-lib-
table  in the KiCad configuration directory, which is system-dependent:

Windows: %APPDATA%\kicad\6.0\sym-lib-table

Linux: ~/.config/kicad/6.0/sym-lib-table

macOS: ~/Library/Preferences/kicad/6.0/sym-lib-table

Pustaka Spesifik untuk Proyek
Libraries listed in Project Specific Libraries table are available to the currently opened project. They are
saved in a sym-lib-table  file in the project directory.

Both library tables are visible by clicking on Global Libraries or Project Specific Libraries tab in the
Manage Library Tables window.

Menambahkan Pustaka Baru
Add a library either by clicking the  button and selecting a file or clicking the  button and typing a path
to a library file. The selected library will be added to the currently opened library table (Global/Project
Specific).
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Menghapus Pustaka
Remove a library by selecting one or more libraries and clicking the  button.

Properti Pustaka
Setiap baris dari tabel pustaka berisi beberapa atribut untuk suatu pustaka:

Active Enables/disables the library. It is useful to temporarily reduce the loaded
library set.

Nickname Nickname is a short, unique identifier used for assigning symbols to
components. Symbols are represented by '<Library Nickname>:<Symbol
Name>' strings.

Library Path Path points to the library location.

Plugin Type Determines the library file format. KiCad 6.0 libraries use the "KiCad"
format, while KiCad 5.x libraries use the "Legacy" format. Legacy
libraries are read-only.

Options Stores library specific options, if used by plugin.

Description Briefly characterizes the library contents.

Preferences

Common Preferences

NOTE TODO: write this section
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Mouse and Touchpad

Center and warp cursor on zoom If checked, the pointed location is warped to the screen center
when zooming in/out.

Use touchpad to pan When enabled, view is panned using scroll wheels (or
touchpad gestures) and to zoom one needs to hold .
Otherwise scroll wheels zoom in/out and /  are the
panning modifiers.

Pan while moving object If checked, automatically pans the window if the cursor leaves
the window during drawing or moving.

Tombol Hotkey
Redefine hotkeys.

Anda bisa mengubah tombol hotkey dengan cara klik-ganda pada aksi yang diinginkan. Klik-kanan pada
salah satu aksi tersebut akan menampilkan menu pop-up berikut ini:

Edit Define a new hotkey for the action (same as double click).

Undo Changes Reverts the recent hotkey changes for the action.

Clear Assigned Hotkey

Restore Default Sets the action hotkey to its default value.

Ctrl

Ctrl Shift
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Display Options

Grid Size Grid size selection.

It is recommended to work with normal grid (0.050 inches or
1,27 mm). Smaller grids are used for component building.

Bus thickness Pen size used to draw buses.

Line thickness Pen size used to draw objects that do not have a specified pen
size.

Part ID notation Style of suffix that is used to denote symbol units (U1A, U1.A,
U1-1, etc.)

Icon scale Adjust toolbar icons size.

Show Grid Grid visibility setting.

Restrict buses and wires to H and V
orientation

If checked, buses and wires are drawn only with vertical or
horizontal lines. Otherwise buses and wires can be placed at
any orientation.

Show hidden pins: Display invisible (or hidden) pins, typically power pins.

Show page limits If checked, shows the page boundaries on screen.

Footprint previews in symbol chooser Displays a footprint preview frame and footprint selector
when placing a new symbol.

Note: it may cause problems or delays, use at your own risk.
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Editing Options

Measurement units Select the display and the cursor coordinate units (inches or
millimeters).

Horizontal pitch of repeated items Increment on X axis during element duplication (default: 0)
(after placing an item like a symbol, label or wire, a
duplication is made by the  key)

Vertical pitch of repeated items Increment on Y axis during element duplication (default:
0.100 inches or 2,54 mm).

Increment of repeated labels Increment of label value during duplication of texts ending in
a number, such as bus members (usual value 1 or -1).

Default text size Text size used when creating new text items or labels.

Auto-save time interval Time in minutes between saving backups.

Automatically place symbol fields If checked, symbol fields (e.g. value and reference) in newly
placed symbols might be moved to avoid collisions with other
items.

Allow field autoplace to change
justification

Extension of 'Automatically place symbol fields' option.
Enable text justification adjustment for symbol fields when
placing a new part.

Always align autoplaced fields to the 50
mil grid

Extension of 'Automatically place symbol fields' option. If
checked, fields are autoplaced using 50 mils grid, otherwise
they are placed freely.

Insert
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Tab Colors
Tab ini berisi skema warna untuk berbagai elemen grafis. Klik pada kotak warna untuk memilih warna baru
untuk elemen yang diinginkan.

Tab Default Fields
Tab ini digunakan untuk membuat atribut-atribut tambahan yang akan muncul pada simbol yang baru
diletakkan.

Menu Help
Akses ke bantuan on-line (dokumen ini) yang berisi tutorial KiCad.

Use the Report a Bug item to report a bug online. Full KiCad version and user system information is
available via the Copy Version Info button in the About KiCad window.
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Bilah Atas Umum
Manajemen Lembar Kerja
The Sheet Settings icon ( ) allows you to define the sheet size and the contents of the title block.

Penomoran lembar kerja diperbarui secara otomatis. Anda dapat mengatur tanggal agar menampilkan
tanggal saat ini dengan menekan tombol panah ke kiri pada kotak "Issue Date", tetapi tanggal ini tidak akan
berubah secara otomatis.

Alat Pencari
The Find icon ( ) can be used to access the search tool.
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Anda dapat melakukan pencarian referensi, nilai atau teks pada lembar kerja yang sedang dibuka atau pada
keseluruhan hirarki. Ketika elemen yang dicari telah ditemukan, kursor akan diposisikan pada elemen
tersebut di dalam anak lembar kerja yang sesuai.

Alat Netlist
The Netlist icon ( ) opens the netlist generation tool.

Alat ini akan membuat sebuah berkas yang berisi penjelasan koneksi pada keseluruhan hirarki.

Pada hirarki dengan banyak lembar kerja, label lokal hanya akan ditampilkan di dalam lembar kerja dimana
ia berada. Sebagai contoh, label LABEL1 pada lembar kerja 3 berbeda dengan LABEL1 pada lembar kerja 5
(jika tidak ada koneksi yang dibuat untuk menghubungkan kedua label tersebut). Hal ini karena nama
lembar kerja terhubung secara internal dengan label lokal.

NOTE Even though there is no text length limit for labels in KiCad, please take into account that
other programs reading the generated netlist may have such constraints.

NOTE
Avoid spaces in labels, because they will appear as separated words in the generated file.
It is not a limitation of KiCad, but of many netlist formats, which often assume that a label
has no spaces.
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Opsi:

Default Format Jika dicentang, maka Pcbnew akan digunakan sebagai format
default.

Eeschema juga bisa menghasilkan berkas dengan beberapa format berikut ini:

Orcad PCB2

CadStar

Spice (simulator)

Plugin eksternal juga bisa ditambahkan untuk mendukung format netlist yang lain (Pada gambar di atas,
ditambahkan plugin PadsPcb).

Informasi lebih lanjut mengenai pembuatan netlist dapat dilihat pada bagian Membuat Netlist.

Alat Anotasi
The icon  launches the annotation tool. This tool assigns references to components.

Untuk komponen-komponen multi-part (misalnya 7400 TTL yang memiliki 4 gate), kita perlu
mengalokasikan sufiks multi-part (maka U3 untuk 7400 TTL akan dibagi menjadi U3A, U3B, U3C, dan U3D).

Anda bisa memberikan anotasi pada keseluruhan komponen atau hanya untuk komponen-komponen baru,
yaitu komponen yang belum diberikan anotasi sebelumnya.
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Pilihan Scope

Use the entire schematic All sheets are re-annotated (default).

Use the current page only Only the current sheet is re-annotated (this option is to be
used only in special cases, for example to evaluate the amount
of resistors in the current sheet.).

Keep existing annotation Conditional annotation, only the new components will be re-
annotated (default).

Reset existing annotation Unconditional annotation, all the components will be re-
annotated (this option is to be used when there are duplicated
references).

Reset, but do not swap any annotated
multi-unit parts

Keeps all groups of multiple units (e.g. U2A, U2B) together
when reannotating.

Urutan Anotasi (Annotation Order)

Pilih urutan penomoran komponen (secara horisontal atau vertikal).
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Pilihan Anotasi (Annotation Choice)

Pilih format referensi yang akan diterapkan.

Alat Electrical Rules Check
The icon  launches the electrical rules check (ERC) tool.

Peralatan ini digunakan untuk melakukan verifikasi desain dan mampu mendeteksi koneksi yang belum
terhubung, serta inkonsistensi.

Once you have run the ERC, KiCad places markers to highlight problems. The error description is displayed
after left clicking on the marker. An error report file can also be generated.

Kotak Dialog Utama ERC

Kesalahan yang ditemukan akan ditampilkan pada kotak dialog ERC, beserta:

Jumlah kesalahan dan peringatan.

Jumlah kesalahan.

Jumlah peringatan.

Opsi:

Create ERC file report Centang opsi ini untuk membuat berkas laporan ERC.

Perintah:
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Delete Markers Hapus semua penanda kesalahan/peringatan ERC.

Run Menjalankan Electrical Rules Check.

Close Tutup kotak dialog.

Klik pada pesan kesalahan akan menampilkan penanda yang terkait di skematik.

Kotak Dialog Opsi ERC

Tab ini digunakan untuk mendefinisikan aturan konektivitas antar pin; Anda dapat memilih salah satu dari
pilihan berikut, untuk setiap kasus:

Tidak ada kesalahan

Peringatan
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Kesalahan

Setiap kotak pada matriks dapat dimodifikasi dengan melakukan klik pada kotak tersebut.

Opsi:

Test similar labels Melaporkan label yang sama namun menggunakan huruf
besar/kecil yang berbeda (contohnya label/Label/LaBeL).
Nama net bersifat case-sensitive, sehingga label dengan
penggunaan huruf besar/kecil yang berbeda akan
diperlakukan sebagai net yang terpisah.

Test unique global labels Melaporkan label global yang muncul hanya satu kali saja
untuk suatu net. Seharusnya diperlukan setidaknya dua buah
label untuk membuat satu koneksi.

Perintah:

Initialize to Default Mengembalikan pengaturan ke awal.

Alat Daftar Komponen (Bill of Materials)
The icon  launches the bill of materials (BOM) generator. This tool generates a file listing the

components and/or hierarchical connections (global labels).
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The Schematic Editor’s BOM generator makes use of external plugins, either as XSLT or Python scripts. There
are a few examples installed inside the KiCad program files directory.

Daftar properti komponen yang diperlukan untuk membuat BOM antara lain:

Value - nama unik untuk setiap komponen yang digunakan.

Footprint - bisa dibuat secara manual atau dari anotasi-mundur (lihat di bawah).

Field1 - nama manufaktur.

Field2 - nomor part manufaktur.

Field3 - nomor part distibutor.

Contoh:
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Pada MS Windows, kotak dialog pembuat BOM memiliki opsi khusus (ditunjukkan oleh panah berwarna
merah) untuk menampilkan jendela plugin eksternal. + Secara default, perintah pembuat BOM diekseksusi
oleh jendela konsol secara tersembunyi dan hasilnya akan diteruskan ke kotak Plugin info. Centang pilihan
ini untuk menampilkan jendela perintah yang sedang berjalan. Hal ini mungkin diperlukan jika plugin
menyediakan antarmuka grafis.
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Alat Pengaturan Atribut
The icon  opens a spreadsheet to view and modify field values for all symbols.



33

Jika Anda sudah selesai memodifikasi nilai suatu atribut, Anda harus menerima perubahan dengan klik
tombol 'Apply' atau membatalkan modifikasi dengan klik tombol 'Revert'.

Tricks to simplify fields filling
There are several special copy/paste methods in spreadsheet. They may be useful when entering field values
that are repeated in a few components.

These methods are illustrated below.
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Copy (Ctrl+C) Selection Paste (Ctrl+V)

NOTE These techniques are also available in other dialogs with a grid control element.

Peralatan Impor Footprint

Cara mengakses:
The icon  launches the back-annotate tool.

This tool allows footprint changes made in the PCB Editor to be imported back into the footprint fields in
the Schematic Editor.
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Manajemen Pustaka Simbol
Symbol libraries hold collections of symbols used when creating schematics. Each symbol in a schematic is
uniquely identified by a full name that is composed of a library nickname and a symbol name. An example is
Audio:AD1853 .

Tabel Pustaka Simbol (Symbol Library Table)
The symbol library table holds a list of all library files KiCad knows about. The symbol library table is
constructed from the global symbol library table file and the project specific symbol library table file.

When a symbol is loaded, KiCad uses the library nickname, Audio  in our example, to lookup the library
location in the symbol library table.

The image below shows the symbol library table editing dialog which can be opened by invoking the
Manage Symbol Libraries…  entry in the Preferences menu.

Tabel Pustaka Simbol Global
The global symbol library table contains the list of libraries that are always available regardless of the
currently loaded project file. The table is saved in the file sym-lib-table in the user’s KiCad configuration
folder. The location of this folder is dependent upon the operating system being used.

Tabel Pustaka Simbol Proyek
Tabel pustaka simbol yang spesifik terhadap proyek berisi daftar pustaka yang tersedia secara khusus untuk
berkas proyek yang saat ini sedang dibuka. Tabel pustaka simbol proyek ini hanya dapat diedit ketika
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dibuka bersama dengan berkas proyek. Jika tidak ada berkas proyek yang sedang dibuka, atau jika tidak ada
berkas tabel pustaka simbol di path proyek yang saat ini sedang dibuka, maka akan dibuat sebuah tabel
kosong yang bisa diedit dan disimpan kemudian bersama dengan berkas proyek.

Konfigurasi Awal
The first time the KiCad Schematic Editor is run and the global symbol table file sym-lib-table  is not found
in the KiCad configuration folder, KiCad will present the "Configure Global Symbol Library Table" dialog to
the user. The dialog presents the user with three options.

Copy default global symbol library table (recommended). If this option is selected, KiCad will copy
the default symbol library table file stored in the system’s Kicad template folder to the file sym-lib-
table  in the user’s KiCad configuration folder. If the default template sym-lib-table  file cannot be
found, this option will be grayed out. The missing default table is usually caused by the KiCad default
libraries not being installed (on some systems they are installed by a separate package). If the libraries
are installed in a non-standard location, use the second option and browse to the library table location
manually.

Copy custom global symbol library table. If this option is selected, the user must browse to the desired
symbol library table file, which will be copied to the user’s KiCad configuration directory.

Create an empty global symbol library table. An empty symbol library table file will be created in the
user’s KiCad configuration directory. The user must add libraries to the table manually.

NOTE

Tabel pustaka simbol default berisi keseluruhan pustaka simbol yang terinstal sebagai
bagian dari KiCad. Hal ini bisa menjadi keuntungan maupun kerugian, tergantung dari
penggunaan dan kecepatan sistem. Jumlah waktu yang dibutuhkan untuk memuat
pustaka simbol proporsional terhadap jumlah pustaka di dalam tabel pustaka simbol. Jika
waktu muat suatu pustaka simbol terlalu lama, hapuslah pustaka yang tidak pernah atau
jarang digunakan dari tabel pustaka global dan tambahkan pustaka tersebut ke tabel
pustaka proyek jika diperlukan.
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Menambahkan Entri Tabel
Untuk dapat menggunakan sebuah pustaka simbol, sebelumnya pustaka tersebut harus ditambahkan ke
tabel global atau tabel proyek. Tabel proyek hanya bisa digunakan jika Anda sedang membuka sebuah
berkas proyek.

NOTE Each library entry must have a unique nickname.

The library nickname does not have to be related in any way to the actual library file name or path. The
colon :  and \  characters cannot be used anywhere in the library nickname. Each library entry must have a
valid path and/or file name depending on the type of library. Paths can be defined as absolute, relative, or by
environment variable substitution (see section below).

The appropriate library format must be selected in order for the library to be properly read. "KiCad" format
is used for KiCad version 6 libraries ( .kicad_sym  files), while "Legacy" format is used for libraries from
older versions of KiCad ( .lib  files). Legacy libraries are read-only, but can be migrated to KiCad format
libraries using the Migrate Libraries button (see section Migrating Legacy Libraries).

Terdapat kolom 'Description' untuk menambahkan penjelasan mengenai entri pustaka tersebut. Kolom
'Option' saat ini tidak digunakan dan tidak ada efek saat memuat pustaka.

Ingat bahwa Anda tidak diperkenankan memiliki nama panggilan yang sama di dalam satu tabel. Namun,
dimungkinkan untuk memiliki nama panggilan yang sama di dalam tabel pustaka global dan proyek.
Entri pada tabel pustaka proyek akan lebih didahulukan daripada entri pada tabel pustaka global jika
ada nama panggilan yang sama. Ketika kita memasukkan suatu entri pada tabel pustaka proyek, sebuah
berkas 'sym-lib-table' yang berisi entri tersebut akan dituliskan ke dalam folder berkas proyek yang saat
ini dibuka. - -

Substitusi Environment Variable
One of the most powerful features of the symbol library table is environment variable substitution. This
allows for definition of custom paths to where symbol libraries are stored in environment variables.
Environment variable substitution is supported by using the syntax ${ENV_VAR_NAME}  in the library path.

By default, at run time KiCad defines two environment variables relevant for locating symbol libraries:

the $KIPRJMOD  environment variable that always points to the currently open project directory.
$KIPRJMOD  cannot be modified.

the $KICAD6_SYMBOL_DIR  environment variable. This points to the path where the default symbol
libraries that were installed with KiCad.

You can override $KICAD6_SYMBOL_DIR  by redefining it in Preferences → Configure Paths… . This is useful
for using libraries installed in a nonstandard location.

$KIPRJMOD  allows you to store libraries in the project path without having to define the absolute path
(which is not always known) to the library in the project specific symbol library table.

Pola Pemakaian
Symbol libraries can be defined either globally or specifically to the currently loaded project. Symbol
libraries defined in the user’s global table are always available and are stored in the sym-lib-table  file in
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the user’s KiCad configuration folder. The project-specific symbol library table is active only for the
currently open project file.

Ada keuntungan dan kerugian untuk masing-masing metode tersebut. Mendefinisikan keseluruhan pustaka
di dalam tabel global berarti pustaka-pustaka tersebut akan selalu tersedia saat dibutuhkan. Namun
kerugiannya adalah waktu yang dibutuhkan untuk memuat pustaka-pustaka tersebut akan bertambah.

Mendefinisikan keseluruhan pustaka simbol di dalam tabel proyek berarti bahwa Anda hanya memiliki
pustaka yang dibutuhkan oleh proyek saja, sehingga akan mengurangi waktu yang dibutuhkan untuk
memuat pustaka-pustaka tersebut. Namun kekurangannya adalah Anda harus selalu mengingat untuk
menambahkan setiap pustaka simbol yang dibutuhkan untuk setiap proyek.

Maka pola pemakaian yang baik adalah mendefinisikan secara global pustaka-pustaka yang umum
digunakan. Sedangkan untuk pustaka-pustaka yang spesifik yang hanya dibutuhkan oleh proyek, kita
definisikan di dalam tabel pustaka proyek. Tidak ada batasan bagi suatu pustaka untuk didefinisikan ke
tabel manapun.

Migrating Legacy Libraries
Legacy libraries ( .lib  files) are read-only, but they can be migrated to KiCad version 6 libraries
( .kicad_sym ). KiCad version 6 libraries cannot be viewed or edited by KiCad versions older than 6.0.0.

Legacy libraries can be converted to KiCad 6 libraries by selecting them in the symbol library table and
clicking the Migrate Libraries button. Multiple libraries can be selected and migrated at once by -
clicking or -clicking.

Libraries can also be converted one at a time by opening them in the Symbol Editor and saving them as a
new library.

Pemetaan Ulang Proyek 'Legacy'
When loading a schematic created prior to the symbol library table implementation, KiCad will attempt to
remap the symbol library links in the schematic to the appropriate library table symbols. The success of this
process is dependent on several factors:

pustaka asli yang digunakan di skematik masih tersedia dan belum berubah dari saat simbol
ditambahkan ke dalam skematik.

semua operasi penyelamatan telah dilakukan ketika terdeteksi untuk membuat sebuah pustaka
penyelamat atau menjaga agar pustaka penyelamat yang ada tetap dalam kondisi terkini.

integritas pustaka tembolok simbol proyek tidak dalam kondisi rusak.

WARNING

Proses pemetaan ulang akan membuat cadangan untuk keseluruhan berkas yang
berubah selama proses pemetaan, di dalam folder 'rescue-backup' di folder proyek.
Selalu buat cadangan secara manual untuk proyek Anda sebelum melakukan pemetaan
ulang, untuk berjaga-jaga jika pemetaan tidak berjalan sebagaimana mestinya.

Ctrl

shift
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WARNING

Operasi penyelamatan dilakukan walaupun telah dinonaktifkan, untuk memastikan
bahwa simbol-simbol yang tepat telah tersedia untuk dipetakan ulang. Jangan
membatalkan operasi ini atau pemetaan ulang akan gagal untuk memetakan simbol-
simbol skematik secara benar. Setiap tautan simbol yang rusak harus diperbaiki secara
manual.

NOTE

If the original libraries have been removed and the rescue was not performed, the cache
library can be used as a recovery library as a last resort. Copy the cache library to a new
file name and add the new library file to the top of the library list using a version of KiCad
prior to the symbol library table implementation.
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Membuat dan Mengedit Skematik
Pengenalan
Sebuah skematik dapat direpresentasikan oleh satu lembar kerja saja. Namun jika skematik tersebut
berukuran besar, akan dibutuhkan beberapa lembar kerja.

A schematic represented by several sheets is hierarchical, and all its sheets (each one represented by its own
file) constitute a complete KiCad schematic. The manipulation of hierarchical schematics will be described in
the Hierarchical Schematics chapter.

Pertimbangan Umum
A schematic designed with KiCad is more than a simple graphic representation of an electronic device. It is
normally the entry point of a development chain that allows for:

Melakukan validasi berdasarkan suatu aturan tertentu (Electrical Rules Check) untuk mendeteksi
kesalahan dan kelalaian.

Pembuatan daftar komponen (BOM) secara otomatis.

Pembuatan netlist untuk perangkat lunak simulasi seperti SPICE.

Defining a circuit for transferring to PCB layout.

Sebuah skematik berisi sejumlah simbol, wire, label, juction, bus, dan power port. Agar skematik lebih mudah
dipahami, Anda bisa meletakkan elemen-elemen grafis tambahan seperti jalur masuk bus, komentar, dan
garis poligon.

Symbols are added to the schematic from symbol libraries. After the schematic is made, the set of
connections and footprints is imported into the PCB editor for designing a board.

Meletakkan dan Mengedit Simbol

Mencari dan Meletakkan Simbol
To load a symbol into your schematic you can use the icon . A dialog box allows you to type the name of

the symbol to load.
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Kotak Dialog 'Choose Symbols' akan menyaring simbol berdasarkan nama, kata kunci, dan deskripsi
menurut apa yang Anda ketikkan ke dalam kotak pencarian. Penyaringan lebih jauh dapat digunakan
dengan cara mengetikkan ke dalam kotak pencarian:

Wildcards: gunakan karakter ?  dan *  yang berarti "karakter apapun" dan "karakter sepanjang
apapun".

Relasional: jika sebuah deskripsi atau kata kunci memiliki tagar dengan format "Key:123", Anda bisa
melakukan pencarian relatif terhadap tagar tersebut dengan mengetikkan "Key>123" (lebih besar dari),
"Key<123" (kurang dari), dsb. Angka bisa terdiri dari salah satu sufiks berikut ini: (huruf besar dan huruf
kecil dianggap sama)

p n u m k meg g t

10 10 10 10 10 10 10 10

ki mi gi ti

2 2 2 2

Regular expression: jika Anda biasa menggunakan regular expression, Anda bisa menggunakannya di
sini. Gaya regular expression yang digunakan adalah wxWidgets Advanced Regular Expression style, yang

-12 -9 -6 -3 3 6 9 12

10 20 30 40

http://docs.wxwidgets.org/3.0/overview_resyntax.html
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mirip dengan regular expression Perl.

If the symbol specifies a default footprint, this footprint will be previewed in the lower right. If the symbol
includes footprint filters, alternate footprints that satisfy the footprint filters can be selected in the
footprint dropdown menu at right.

After selecting a symbol to place, the symbol will be attached to the cursor. Left clicking the desired location
in the schematic places the symbol into the schematic. Before placing the symbol in the schematic, you can
rotate it, mirror it, and edit its fields, by either using the hotkeys or the right-click context menu. These
actions can also be performed after placement.

Berikut ini contoh peletakan simbol:

If the "Place repeated copies" option is checked, after placing a symbol KiCad will start placing another copy
of the symbol. This process continues until the user presses .

For symbols with multiple units, if the "Place all units" option is checked, after placing the symbol KiCad will
start placing the next unit in the symbol. This continues until the last unit has been placed or the user
presses .

Placing power ports
A power port symbol is a symbol representing a connection to a power net. The symbols are grouped in the
power  library, so they can be placed using the symbol chooser. However, as power placements are frequent,

Esc

Esc
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the  tool is available. This tool is similar, except that the search is done directly in the power  library.

Mengedit dan Modifikasi Simbol (untuk komponen yang telah diletakkan)
Ada dua cara untuk mengedit sebuah simbol:

Modifikasi pada simbol itu sendiri: posisi, orientasi, pemilihan satuan pada simbol dengan pilihan
satuan.

Modifikasi pada atribut simbol: referensi, nilai, footprint, dsb.

Setelah simbol diletakkan pada lembar kerja, Anda mungkin perlu untuk mengubah nilainya (khusunya
untuk resistor, kapasitor, dsb.), namun Anda tidak perlu segera memberikan nomor referensi, atau memilih
satuan (kecuali untuk komponen dengan satuan terkunci, di mana Anda harus memilih secara manual). Hal
ini dapat dilakukan secara otomatis dengan menggunakan fungsi anotasi.

Modifikasi Simbol
Untuk memodifikasi fitur-fitur dari sebuah simbol, letakkan kursor pada simbol, dan lakukan salah satu
dari aksi berikut:

Klik-ganda pada simbol untuk membuka kotak dialog editor simbol.

Klik-kanan untuk membuka menu konteks dan gunakan salah satu dari perintah berikut: Pindahkan,
Putar, Edit, Hapus, dsb.

Use a hotkey to perform an action on the symbol (  to open the properties dialog,  to rotate, etc.).
Note that hotkeys act on the selected symbol; if no symbol is selected hotkeys act on the symbol under
the cursor.

Symbols can also be selected by clicking on them or drag-selecting them. Selected symbols can be modified
by clicking relevant buttons in the top toolbar or using a hotkey.

Modifikasi Atribut Teks
Anda dapat memodifikasi referensi, nilai, posisi, orientasi, ukuran teks, dan tampilan dari atribut dengan
cara berikut:

Klik-ganda pada atribut teks untuk melakukan modifikasi.

Klik-kanan untuk membuka menu konteks dan gunakan salah satu dari perintah berikut: Pindahkan,
Putar, Edit, Hapus, dsb.

Position the cursor over the field (if nothing is selected) or select the field and press  to edit the field.

Position the cursor over the symbol (if nothing is selected) or select the symbol and press , , or 
hotkeys to directly edit the symbol’s value, reference designator, or footprint fields, respectively.

Untuk modifikasi lanjutan, atau untuk membuat suatu atribut, klik-ganda pada simbol untuk membuka
kotak dialog 'Symbol Properties'.

E R

E

V U F
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Setiap atribut dapat ditampilkan atau disembunyikan, dan dapat ditampilkan secara vertikal atau
horisontal. Posisi yang dipilih selalu diindikasikan untuk simbol yang ditampilkan secara normal (tidak
diputar atau dicerminkan) dan relatif terhadap titik jangkar dari simbol.

The position and orientation properties of each field may be hidden in this dialog. They can be shown by
right-clicking on the column header of the fields table and enabling the "Orientation", "X Position", and/or "Y
Position" columns. Other columns can be shown or hidden as desired.

The "Update Symbol from Library… " button is used to update the schematic’s copy of the symbol to match
the copy in the library. The "Change Symbol… " button is used to swap the current symbol to a different
symbol in the library.

"Edit Symbol… " opens the Symbol Editor to edit the copy of the symbol in the schematic. Note that the
original symbol in the library will not be modified. The "Edit Library Symbol… " button opens the Symbol
Editor to edit the original symbol in the library. In this case, the symbol in the schematic will not be modified
until the user clicks the "Update Symbol from Library… " button.

Electrical Connections

Pengenalan
There are a number of elements that can be added to a schematic to electrically connect components. All of
these elements can be placed with the buttons on the vertical right toolbar or using hotkeys.

Elemen-elemen tersebut antara lain:

Wires: direct connection between pins.

Buses: connections for a group of signals.
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Bus entries: connections between wires and buses.

No-connection flags: terminations for pins or wires that are intentionally unconnected. These flags
prevent ERC violations for unconnected pins.

Junctions: connections between crossing wires or buses.

Net labels: local name for a signal. Signals within a sheet that have the same net label are connected.

Global labels: global name for a signal. Signals with the same global label are connected even if they are
not in the same sheet.

Hierarchical labels: a label for a signal in a subsheet that enables the signal to be accessed in a parent
sheet. See the Hierarchical Schematics section for more information about hierarchical labels, sheets, and
pins.

Hierarchical sheets: an instantiation of a subsheet within a parent sheet. The parent sheet can connect
to the subsheet through the subsheet’s hierarchical pins.

Hierarchical pins: connection points between a parent sheet and a subsheet. Hierarchical pins appear at
the parent sheet’s level and correspond to hierarchical labels in the subsheet.

Several other types of items can be placed on the schematic but do not affect connectivity:

Graphical lines: graphical lines for presentation.

Text: textual comments and annotations.

Bitmap images: raster graphics from an external file.

This section will also discuss two special types of symbols that can be added with the "Power port" button on
the right toolbar:

Power ports: symbols for connecting wires to a power or ground net.

PWR_FLAG: a specific symbol for indicating that a net is powered when it is not connected to a power
output pin (for example, a power net that is supplied by an off-board connector).

Koneksi (Wire dan Label)
Ada dua cara untuk membuat suatu koneksi:

Wire dari pin ke pin.

Label.

Gambar berikut menunjukkan dua metode tersebut:
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Label Connections
The point of "contact" of a label is the small square in the corner of the label. The square disappears when
the label is connected. The position of the connection point relative to the label text can be changed by
choosing a different label orientation in the label properties, or by mirroring/rotating the label.

The label’s connection point must be in contact with a wire or the end of a pin for the label to be connected.

Wire Connections
Untuk membuat suatu koneksi, satu segmen dari wire ujungnya harus dihubungkan ke segmen yang lain
atau ke sebuah pin.

Jika terjadi wire yang saling melintas (jika sebuah wire melewati sebuah pin, namun tidak terhubung ke
ujung pin), maka koneksi tidak terjadi.

NOTE

Wires connect with other wires or pins only if their ends conincide exactly. Therefore it is
important to keep symbol pins and wires aligned to the grid. It is recommended to always
use a 50 mil grid when placing symbols and drawing wires because the KiCad standard
symbol library and all libraries that follow its style also use a 50 mil grid.

NOTE Symbols, wires, and other elements that are not aligned to the grid can be snapped back to
the grid by selecting them, right clicking, and selecting "Align Elements to Grid."

Wire Junctions
Wires that cross are not implicitly connected. It is necessary to join them with a junction dot if a connection
is desired. Junction dots will be automatically added to wires that start or end on top of an existing wire.
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Junction dots are used in the previous figure on the wires connected to P1  pins 18, 19, 20, 21, 22, and 23.

Nets with Multiple Names
A signal can only have one name. If two different labels are placed on the same net, an ERC violation will be
generated. Only one of the net names will be used in the netlist.

Hidden Power Pins
When the power pins of a symbol are visible, they must be connected, as with any other signal.

However, symbols such as gates and flip-flops are sometimes drawn with hidden power input pins which are
connected implicitly.

KiCad automatically connects invisible pins with type "power input" to a global net with the same name as
the pin. For example, if a symbol has a hidden power input pin named VCC , this pin will automatically be
connected to the global VCC  net.

NOTE

Care must be taken with hidden power input pins because they can create unintentional
connections. By nature, hidden pins are invisible and do not display their pin name. This
makes it easy to accidentally connect two power pins to the same net. For this reason, the
use of invisible power pins in symbols is not recommended outside of power port
symbols, and is only supported for compatibility with legacy designs and symbols.

NOTE
Hidden pins can be shown in the schematic by checking the Show hidden pins option in
the Schematic Editor → Display Options section of the preferences, or by selecting View
→ Show hidden pins. There is also a toggle icon  on the left (options) toolbar.

It may be necessary to join power nets of different names (for example, GND  in TTL components and VSS  in
MOS components). To accomplish this, add a <<power-ports,power port symbol> for each net and connect
them with a wire.

It is not recommended to use labels for power connection. These only have a "local" connection scope, and
will not connect to invisible power pins.

Wiring
To begin connecting elements, you may either use the 'Wire' or 'Bus' tools from the right-hand toolbar, or
you can auto-start a new wire from any existing pin or unconnected wire.

The wire drag action will drag the entire wire if you start dragging from the middle of the wire.
Alternatively, it will drag just one corner if you start the drag action over a corner where two wires connect

Koneksi (Bus)
Pada skematik berikut, ada beberapa pin yang terhubung ke bus.
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Anggota Bus
Buses are a way to group related signals in the schematic in order to simplify complicated designs. Buses can
be drawn like wires using the bus tool, and are named using labels the same way signal wires are. There are
two types of bus in KiCad 6.0 and later: vector buses and group buses.

A vector bus is a collection of signals that start with a common prefix and end with a number. Vector buses
are named <PREFIX>[M..N]  where PREFIX  is any valid signal name, M  is the first suffix number, and N  is
the last suffix number. For example, the bus DATA[0..7]  contains the signals DATA0 , DATA1 , and so on up to
DATA7 . It doesn’t matter which order M  and N  are specified in, but both must be non-negative.

A group bus is a collection of one or more signals and/or vector buses. Group buses can be used to bundle
together related signals even when they have different names. Group buses use a special label syntax:

<OPTIONAL_NAME>{SIGNAL1 SIGNAL2 SIGNAL3}

The members of the group are listed inside curly braces ( {} ) separated by space characters. An optional
name for the group goes before the opening curly brace. If the group bus is unnamed, the resulting nets on
the PCB will just be the signal names inside the group. If the group bus has a name, the resulting nets will
have the name as a prefix, with a period ( . ) separating the prefix from the signal name.

For example, the bus {SCL SDA}  has two signal members, and in the netlist these signals will be SCL  and
SDA . The bus USB1{DP DM}  will generate nets called USB1.DP  and USB1.DM . For designs with larger buses
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that are repeated across several similar circuits, using this technique can save time.

Group buses can also contain vector buses. For example, the bus MEMORY{A[7..0] D[7..0] OE WE}  contains
both vector buses and plain signals, and will result in nets such as MEMORY.A7  and MEMORY.OE  on the PCB.

Bus wires can be drawn and connected in the same manner as signal wires, including using junctions to
create connections between crossing wires. Like signals, buses cannot have more than one name — if two
conflicting labels are attached to the same bus, an ERC violation will be generated.

Koneksi Antar Anggota Bus
Pins connected between the same members of a bus must be connected by labels. It is not possible to
connect a pin directly to a bus; this type of connection will be ignored by KiCad.

Pada contoh di atas, koneksi dibuat dengan menggunakan label yang diletakkan pada wire yang terhubung
ke pin. Jalur masuk bus (wire dengan sudut 45 derajat) hanya bersifat grafis, dan tidak diperlukan untuk
membuat koneksi logis.

In fact, using the repetition command ( ), connections can be very quickly made in the following way,
if component pins are aligned in increasing order (a common case in practice on components such as
memories, microprocessors… ):

Place the first label (for example PCA0 )

Use the repetition command as much as needed to place members. KiCad will automatically create the
next labels ( PCA1 , PCA2… ) vertically aligned, theoretically on the position of the other pins.

Tariklah wire di bawah label pertama. Lalu gunakan perintah repetisi untuk meletakkan wire berikutnya
di bawah label yang sudah dibuat.

Jika diperlukan, letakkan jalur masuk bus dengan cara yang sama (Letakkan jalur masuk yang pertama,
lalu gunakan perintah repetisi).

NOTE

In the Schematic Editor → Editing Options section of the Preferences menu, you can set
the repetition parameters:

Horizontal pitch.

Vertical pitch.

Label increment (labels can be incremented or decremented by 1, 2, 3, etc.).

Bus unfolding
The unfold tool allows you to quickly break out signals from a bus. To unfold a signal, right-click on a bus
object (a bus wire, etc) and choose Unfold from Bus. Alternatively, use the Unfold Bus hotkey (default: )
when the cursor is over a bus object. The menu allows you to select which bus member to unfold.

After selecting the bus member, the next click will place the bus member label at the desired location. The
tool automatically generates a bus entry and wire leading up to the label location. After placing the label, you
can continue placing additional wire segments (for example, to connect to a component pin) and complete
the wire in any of the normal ways.

Insert

C



50

Bus aliases
Bus aliases are shortcuts that allow you to work with large group buses more efficiently. They allow you to
define a group bus and give it a short name that can then be used instead of the full group name across the
schematic.

To create bus aliases, open the Bus Definitions dialog in the Tools menu.

An alias may be named any valid signal name. Using the dialog, you can add signals or vector buses to the
alias. As a shortcut, you can type or paste in a list of signals and/or buses separated by spaces, and they will
all be added to the alias definition. In this example, we define an alias called USB  with members DP , DM , and
VBUS .

After defining an alias, it can be used in a group bus label by putting the alias name inside the curly braces of
the group bus: {USB} . This has the same effect as labeling the bus {DP DM VBUS} . You can also add a prefix
name to the group, such as USB1{USB} , which results in nets such as USB1.DP  as described above. For
complicated buses, using aliases can make the labels on your schematic much shorter. Keep in mind that the
aliases are just a shortcut, and the name of the alias is not included in the netlist.

Bus aliases are saved in the schematic file. Any aliases created in a given schematic sheet are available to use
in any other schematic sheet that is in the same hierarchical design.
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Buses with more than one label
KiCad 5.0 and earlier allowed the connection of bus wires with different labels together, and would join the
members of these buses during netlisting. This behavior has been removed in KiCad 6.0 because it is
incompatible with group buses, and also leads to confusing netlists because the name that a given signal will
receive is not easily predicted.

If you open a design that made use of this feature in a modern version of KiCad, you will see the Migrate
Buses dialog which guides you through updating the schematic so that only one label exists on any given set
of bus wires.

For each set of bus wires that has more than one label, you must choose the label to keep. The drop-down
name box lets you choose between the labels that exist in the design, or you can choose a different name by
manually entering it into the new name field.

Power Ports
Power port symbols are conventionally used to connect pins to power nets. Power port symbols have a
single pin which is invisible and marked as a power input. As described in the hidden power pins section, any
wire connected to the pin of a power port is therefore automatically connected to the power net with the
same name as the port’s pin.

In the KiCad standard library, power ports are found in the power  library, but power port symbols can be
created in any library. To create a custom power port, make a new symbol with a hidden pin marked as a
power input. Name the pin according to the desired power net.

Gambar di bawah ini menampilkan sebuah contoh koneksi port power.
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In this example, power ports symbols are used to connect the positive and negative terminals of the
capacitors to the VCC  and GND  nets, respectively.

Power port symbols are found in the power  symbol library. They can also be created by drawing a symbol
with a hidden "power input" pin that has the name of the desired power net.

PWR_FLAG
Two PWR_FLAG  symbols are visible in the screenshot above. They indicate to ERC that the two power nets
VCC  and GND  are actually connected to a power source, as there is no explicit power source such as a
voltage regulator output attached to either net.

Without these two flags, the ERC tool would diagnose: Error: Input Power pin not driven by any Output
Power pins.

The PWR_FLAG  symbol is found in the power  symbol library. The same effect can be achieved by connecting
any "Power Output" pin to the net.

No-connection flag
No-connection flags ( ) are used to indicate that a pin is intentionally unconnected. These flags do not

have any effect on the schematic’s connectivity, but they prevent "unconnected pin" ERC warnings for pins
that are intentionally unconnected.

Peralatan Pelengkap Gambar

Text comments and graphic lines
It can be useful to place annotations such as text fields and frames to aid in understanding the schematic.

Text fields ( ) and graphic lines ( ) are intended for this use, as opposed to labels and wires, which are

connection elements.
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The image below shows graphic lines and text in addition to wires, local labels, and hierarchical labels.

Blok Judul pada Lembar Kerja
The title block is edited with the Page Settings tool ( ).
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Each field in the title block can be edited, as well as the paper size and orientation. If the "Export to other
sheets" option is checked for a field, that field will be updated in the title block of all sheets, rather than only
the current sheet.

A drawing sheet template file can also be selected.

The sheet number (Sheet X/Y) is automatically updated, but sheet page numbers can also be manually set
using Edit → Edit Sheet Page Number… .

Menyelamatkan tembolok simbol
By default, KiCad loads symbols from the project libraries according to the set paths and library order. This
can cause a problem when loading a very old project: if the symbols in the library have changed or have
been removed or the library no longer exists since they were used in the project, the ones in the project
would be automatically replaced with the new versions. The new versions might not line up correctly or
might be oriented differently leading to a broken schematic.

When a project is saved, a cache library with the contents of the current library symbols is saved along with
the schematic. This allows the project to be distributed without the full libraries. If you load a project where
symbols are present both in its cache and in the system libraries, KiCad will scan the libraries for conflicts.
Any conflicts found will be listed in the following dialog:
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Anda bisa melihat pada contoh di atas bahwa proyek yang awalnya menggunakan sebuah dioda dengan
katoda berada di atas, namun pustaka yang tersedia sekarang berisi dioda dengan katoda berada di bawah.
Perubahan ini akan membuat skematik menjadi rusak! Jika kita menekan tombol OK, maka pustaka
tembolok akan disimpan ke dalam pustaka khusus "'rescue'" dan semua simbol akan dinamai ulang untuk
mencegah konflik dalam penamaan.

If you press Cancel, no rescues will be made, so KiCad will load all the new components by default. If you
save the schematic at this point, your cache will be overwritten and the old symbols will not be recoverable.
If you have saved the schematic, you can still go back and run the rescue function again by selecting "Rescue
Cached Components" in the "Tools" menu to call up the rescue dialog again.

Jika Anda tidak ingin menampilkan kotak dialog ini, Anda bisa memilih tombol "'Never show Again'". Secara
default, Eeschema tidak akan melakukan apapun dan akan memuat seluruh komponen baru. Pilihan ini
dapat diubah kembali pada menu "'Preferences'".
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Skematik Hirarkis
Pengenalan
Representasi hirarkis secara umum menjadi solusi yang baik untuk proyek yang lebih besar dari beberapa
lembar kerja. Jika Anda ingin menangani proyek semacam ini, Anda perlu untuk:

Menggunakan lembar kerja yang besar, yang akan menyebabkan skematik menjadi sulit ditangani dan
dicetak.

Menggunakan beberapa lembar kerja, yang akan menjadikan skematik terstruktur secara hirarkis.

Skematik yang lengkap akan terdiri dari satu lembar kerja utama, yang disebut lembar kerja 'root', dan anak
lembar kerja yang menyusun hirarki. Pembagian desain menjadi beberapa lembar kerja yang terpisah bisa
memudahkan pembacaan.

From the root sheet, you must be able to find all sub-sheets. Hierarchical schematics management is very

easy with KiCad, thanks to an integrated "hierarchy navigator" accessible via the icon  of the top toolbar.

Ada dua tipe hirarki, di mana keduanya bisa digunakan bersamaan: tipe pertama telah umum digunakan.
Tipe kedua terdiri dari pembuatan simbol-simbol pada pustaka yang tampak seperti simbol biasa di
skematik, tetapi sebenarnya berhubungan dengan sebuah skematik yang menjelaskan struktur internalnya.

Tipe yang kedua digunakan untuk mengembangkan 'Integrated Circuit', karena dalam kasus ini Anda harus
menggunakan pustaka fungsi di dalam skematik.

KiCad currently doesn’t treat this second case.

Sebuah hirarki bisa:

sederhana: satu lembar kerja hanya digunakan satu kali saja

kompleks: satu lembar kerja dapat digunakan lebih dari satu kali (beberapa kali kemunculan)

rata: adalah hirarki yang sederhana, namun koneksi antar lembar kerja tidak digambarkan.

KiCad can deal with all these hierarchies.

Pembuatan skematik hirarkis sangat mudah, keseluruhan hirarki ditangani mulai dari skematik utama,
seperti jika anda hanya memiliki satu skematik.

Dua langkah penting untuk dipahami antara lain:

Bagaimana cara membuat anak lembar kerja.

Bagaimana cara membangun koneksi-koneksi elektrikal antar anak lembar kerja.

Penelusuran Hirarki
Navigation among sub-sheets is acheived by using the navigator tool accessible via the button  on the

top toolbar.
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Untuk memilih lembar kerja, klik pada nama lembar kerja tersebut. Untuk membuka, klik-kanan pada nama
lembar kerja, dan pilih 'Enter Sheet' atau klik-ganda dalam batas lembar kerja.

Untuk keluar dari lembar kerja yang sedang dibuka menuju ke lembar kerja utama, klik-kanan pada
skematik, dan pilih 'Leave Sheet' pada menu konteks, atau tekan 'Alt+Backspace'.

Label Lokal, Hirarkis, dan Global

Properti
Local labels, tool , are connecting signals only within a sheet. Hierarchical labels (tool ) are

connecting signals only within a sheet and to a hierarchical pin placed in the parent sheet.

Global labels (tool ) are connecting signals across all the hierarchy. Power pins (type power in and power

out) invisible are like global labels because they are seen as connected between them across all the
hierarchy.

NOTE Di dalam satu hirarki (sederhana atau kompleks), kita bisa menggunakan label hirarkis
maupun label global.

Membuat Hirarki
Anda perlu melakukan:

Meletakkan simbol hirarki "'sheet symbol'" di lembar kerja utama.

Masuk ke skematik baru (anak lembar kerja) dengan menggunakan navigator, dan menggambar
skematik seperti biasa.

Menggambar koneksi-koneksi elektrik antar kedua skematik dengan meletakkan label global (HLabels)
pada skematik yang baru (anak lembar kerja), dan label yang memiliki nama yang sama di lembar kerja
utama, disebut SheetLabels. SheetLabels akan terhubung ke simbol lembar kerja dari lembar kerja
utama ke elemen-elemen yang lain dari skematik, seperti pin-pin simbol standar.

Simbol Lembar Kerja
Kita perlu membuat sebuah persegi yang akan menggambarkan anak lembar kerja.
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Ukuran dari persegi ini harus cukup untuk meletakkan label-label dan pin hirarkis, yang berhubungan
dengan label global (HLabels) pada anak lembar kerja.

These labels are similar to usual symbol pins. Select the tool .

Klik untuk meletakkan sudut kiri atas persegi. Klik sekali lagi untuk meletakkan sudut kanan bawah, dan
pastikan ukuran persegi cukup besar.

Akan muncul kotak dialog untuk mengatur nama berkas dan nama lembar kerja yang dibuat. Nama lembar
kerja ini digunakan untuk mengakses skematik menggunakan navigator hirarki.

Anda harus menuliskan setidaknya sebuah nama berkas. Jika tidak ada nama lembar kerja, maka nama
berkas akan digunakan sebagai nama lembar kerja.

Koneksi - Pin Hirarkis
Anda akan membuat titik koneksi (pin-pin hirarki) untuk simbol yang telah dibuat.

Titik-titik koneksi tersebut mirip dengan pin simbol normal, namun bisa menghubungkan sebuah bus yang
lengkap dengan hanya satu titik koneksi.

Importing Hierarchical Sheet Pins
Select the tool .

Click on the hierarchical sheet from where you want to import the pins corresponding to hierarchical
labels placed in the corresponding schematic. A hierarchical pin appears, if a new hierarchical label
exists, i.e. not corresponding to an already placed pin.

Klik di mana Anda ingin meletakkan pin ini.

All necessary pins can thus be placed quickly and without error. Their aspect is in accordance with
corresponding hierarchical labels.

Koneksi - Label Hirarkis
Each pin of the sheet symbol just created, must correspond to a label called hierarchical Label in the sub-
sheet. Hierarchical labels are similar to labels, but they provide connections between sub-sheet and root
sheet. The graphical representation of the two complementary labels (pin and hierarchical labels) is similar.

Hierarchical labels are made with the tool .

Lihat contoh lembar kerja utama di bawah ini:
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Perhatikan pin VCC_PIC, terhubung ke konektor JP1.

Berikut adalah koneksi yang terkait pada anak lembar kerja:

Kembali Anda temukan dua label hirarkis yang terkait, yang menghubungkan antar dua lembar kerja
hirarkis.

NOTE Anda bisa menggunakan label hirarkis dan pin hirarkis untuk menghubungkan dua bus,
menurut sintaks (Bus [N..m]) yang telah dijelaskan sebelumnya.

Label, Label Hirarkis, Label Global, dan Pin Power Tersembunyi
Berikut beberapa komentar mengenai berbagai cara untuk membuat suatu koneksi, selain koneksi wire.
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Label Sederhana
Label sederhana memiliki koneksi dengan kapasitas lokal, yaitu terbatas pada lembar kerja skematik di
mana label tersebut diletakkan. Hal ini karena:

Setiap lembar kerja memiliki nomor lembar kerja.

Nomor lembar kerja ini terkait dengan label.

Maka, jika Anda meletakkan label "TOTO" pada lembar kerja n° 3, sebenarnya nama label ini adalah
"TOTO_3". Jika Anda juga meletakkan sebuah label "TOTO" pada lembar kerja n° 1 (lembar kerja utama),
Anda sebenarnya meletakkan label "TOTO_1", berbeda dari "TOTO_3". Hal ini berlaku meskipun hanya ada
satu lembar kerja saja.

Label Hirarkis
Sifat-sifat label sederhana juga berlaku untuk label hirarkis.

Dengan demikian pada lembar kerja yang sama, sebuah label hirarkis "TOTO" akan terhubung ke label lokal
"TOTO", tetapi tidak terhubung ke label hirarkis atau label "TOTO" di lembar kerja lain.

Label hirarkis akan terhubung ke simbol pin lembar kerja yang sesuai pada simbol hirarkis yang diletakkan
di lembar kerja utama.

Pin Power Tersembunyi
Pin power yang tersembunyi akan saling terhubung jika memiliki nama yang sama. Maka pin power
tersembunyi dengan nama VCC akan terhubung dengan semua pin power tersembunyi lainnya yang juga
bernama VCC, namun hanya di dalam satu lembar kerja saja.

Artinya, jika Anda meletakkan label VCC pada suatu anak lembar kerja, label tersebut tidak akan terhubung
ke pin VCC, karena nama sebenarnya dari label ini adalah VCC_n, di mana n adalah nomor lembar kerja.

Jika Anda ingin supaya label VCC tersebut terhubung dengan label VCC di keseluruhan skematik, Anda harus
menghubungkannya secara eksplisit ke pin power tersembunyi melalui simbol power VCC.

Label Global
Label global yang memiliki nama yang sama akan terhubung di keseluruhan hirarki.

(label power seperti vcc …  adalah label global)

Hirarki Kompleks
Berikut adalah suatu contoh. Skematik yang sama digunakan sebanyak dua kali (dua kemunculan). Dua buah
lembar kerja berbagi skematik yang sama karena kedua lembar kerja tersebut menggunakan nama berkas
yang sama ("other_sheet.sch"). Sedangkan nama lembar kerja harus unik.
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Hirarki Datar
Anda bisa membuat sebuah proyek menggunakan banyak lembar kerja tanpa harus membuat koneksi antar
lembar kerja tersebut (hirarki datar) jika Anda mengikuti aturan berikut:

Buat sebuah lembar kerja utama berisi lembar kerja yang lain, yang berfungsi sebagai tautan antara
lembar kerja.

Tidak diperlukan koneksi eksplisit.

Gunakan label global pada semua lembar kerja, dan jangan menggunakan label hirarkis.

Berikut adalah contoh lembar kerja utama.
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Berikut ini dua halaman yang terhubung oleh label global.

Berikut adalah pic_programmer.sch .

Berikut adalah pic_sockets.sch .
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Perhatikan label global yang digunakan.
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Alat Anotasi Simbol
Pengenalan
The annotation tool allows you to automatically assign a designator to symbols in your schematic.
Annotation of symbols with multiple units will assign a unique suffix to minimize the number of these

symbols. The annotation tool is accessible via the icon . Here you find its main window.

Berikut skema anotasi yang tersedia:

Memberikan anotasi pada semua simbol (mereset pilihan anotasi sebelumnya)

Memberikan anotasi pada semua simbol, namun jangan melakukan anotasi ulang pada simbol yang
terdiri dari beberapa bagian, yang telah mendapatkan anotasi sebelumnya.

Memberikan anotasi hanya pada simbol yang belum mendapatkan anotasi sebelumnya. Simbol yang
belum mendapatkan anotasi akan memiliki penunjuk yang berakhiran dengan tanda "'?'".

Memberikan anotasi pada keseluruhan hirarki (gunakan opsi 'Use the entire schematic').

Memberikan anotasi hanya pada lembar kerja yang sedang dibuka (gunakan opsi 'Use the current page
only').
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Opsi 'Reset, but do not swap any annotated multi-unit parts' akan mempertahankan semua asosiasi yang
telah ada pada simbol yang terdiri dari beberapa bagian. Sebagai contoh, U2A dan U2B bisa mendapatkan
anotasi ulang ke U1A dan U1B, namun mereka tidak akan mendapatkan anotasi ulang meenjadi U1A dan
U2A, ataupun ke U2B dan U2A. Hal ini berguna jika Anda ingin memastikan agar pengelompokan pin tetap
terjaga.

Kita bisa memilih urutan anotasi untuk mengatur nomor referensi di dalam setiap lembar kerja pada
hirarki.

Kecuali untuk kasus-kasus tertentu, anotasi otomatis dapat diterapkan ke keseluruhan proyek (semua
lembar kerja) dan ke komponen baru, jika Anda tidak ingin mengubah hasil anotasi sebelumnya.

Kita bisa memilih metode yang digunakan untuk melakukan kalkulasi referensi:

'Use first free number in schematic': komponen akan diberikan anotasi mulai dari angka 1 (untuk tiap
prefiks referensi). Jika sudah ada anotasi sebelumnya, maka nomor yang akan diberikan hanya nomor
yang belum digunakan.

'Start to sheet number*100 and use first free number': anotasi akan dimulai dari 101 untuk lembar kerja
1, dari 201 untuk lembar kerja 2, dst. Jika terdapat lebih dari 99 item yang memiliki prefiks referensi yang
sama (U, R) di dalam lembar kerja 1, maka alat anotasi akan menggunakan nomor 200 dan seterusnya,
dan anotasi untuk lembar kerja 2 akan dimulai dari nomor bebas berikutnya.

'Start to sheet number*1000 and use first free number': anotasi dimulai dari 1001 untuk lembar kerja 1,
dari 2001 untuk lembar kerja 2.

Contoh Penggunaan

Urutan Anotasi
Contoh berikut menunjukkan 5 buah elemen yang telah diletakkan, namun belum dilakukan anotasi.

Setelah alat anotasi dijalankan, didapatkan hasil berikut.

Diurutkan berdasarkan sumbu X.
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Diurutkan berdasarkan sumbu Y.

Amati bahwa keempat gate 74LS00 didistribusikan sebagai paket U1, sedangkan 74LS00 yang kelima
mendapatkan penomoran berikutnya, yaitu U2.

Pilihan Anotasi
Berikut adalah anotasi pada lembar kerja 2 di mana digunakan opsi 'Use first free number in schematic'.

Opsi 'start to sheet number*100 and use first free number' memberikan hasil berikut.
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Opsi 'Start to sheet number*1000 and use first free number' memberikan hasil berikut.
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Verifikasi Desain dengan Electrical Rules
Check
Pengenalan
Electrical Rules Check (ERC) bertugas melakukan pemeriksaan otomatis pada skematik Anda. ERC akan
memeriksa adanya kesalahan pada lembar kerja Anda, seperti pin yang belum terhubung, simbol hirarkis
yang belum terhubung, keluaran yang mengalami hubung-singkat, dsb. Namun perlu diingat bahwa
pemeriksaan otomatis tidak bisa memeriksa secara sempurna, dan perangkat lunak yang mampu
mendeteksi semua kesalahan desain belum sepenuhnya lengkap. Pemeriksaan seperti ini sangat berguna,
karena Anda bisa mendeteksi kekeliruan dan kesalahan-kesalahan kecil dengan mudah.

In fact all detected errors must be checked and then corrected before proceeding as normal. The quality of
the ERC is directly related to the care taken in declaring electrical pin properties during symbol library
creation. ERC output is reported as errors'' or warnings''.

Penggunaan ERC
ERC can be started by clicking on the icon .

Akan muncul penanda pada elemen skematik yang menyebabkan kesalahan ERC (pin atau label).

NOTE

Pada kotak dialog ini, saat Anda melakukan klik pada pesan kesalahan, Anda akan
diarahkan ke penanda yang terkait pada skematik.

Pada skematik, klik-kanan pada penanda untuk mengakses pesan hasil pemeriksaan
yang terkait.
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You can also delete error markers from the dialog and set specific ERC messages to be suppressed by using
the right-click context menu.

Contoh ERC

Pada gambar di atas, Anda bisa melihat adanya empat kesalahan:

Dua keluaran telah tersambung secara tidak sengaja (tanda panah warna merah).

Dua masukan belum tersambung (tanda panah warna hijau).

Terdapat kesalahan pada port power tersembunyi, dimana tidak ada bendera power (tanda panah warna
hijau di atas).

Menampilkan Hasil Pemeriksaan
Klik-kanan pada penanda kesalahan. Akan muncul menu pop-up untuk mengakses kotak dialog hasil
pemeriksaan ERC.
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Klik 'Marker Error Info' untuk menampilkan deskripsi kesalahan.

Pin dan Bendera Power
Kita akan sering menjumpai kesalahan atau peringatan pada pin-pin power, meskipun sepertinya semuanya
tampak normal. Perhatikan contoh di atas. Hal ini terjadi karena, pada kebanyakan desain, power disediakan
oleh konektor yang bukan merupakan sumber tenaga (seperti keluaran regulator, yang dinyatakan sebagai
Power out).

Maka, ERC tidak akan menemukan adanya pin Power out untuk mengendalikan wire ini, dan akan
menyatakan bahwa wire tersebut tidak terhubung ke sumber tenaga.

Untuk menghindari peringatan ini, Anda harus meletakkan sebuah "PWR_FLAG" pada port power tersebut.
Perhatikan contoh berikut:
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Penanda kesalahan akan menghilang.

Seringkali, PWR_FLAG harus dihubungkan ke GND, karena regulator memiliki keluaran yang dinyatakan
sebagai Power out, akan tetapi pin ground bukanlah Power out (atribut normalnya adalah Power in),
sehingga tanpa adanya simbol PWR_FLAG, ground tidak akan tampak terhubung ke sumber tenaga.

Konfigurasi
The Pin Conflicts Map panel in Schematic Setup allows you to configure connectivity rules to define electrical
conditions for errors and warnings based on what types of pins are connected to each other

Aturan dapat diubah dengan melakukan klik pada kotak yang diinginkan pada matriks. Pilihan yang tersedia
adalah 'normal', 'warning', dan 'error'.
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The Violation Severity panel in Schematic Setup lets you configure what types of ERC messages should be
reported as Errors, Warnings or ignored.

Berkas Laporan ERC
Berkas laporan ERC dapat dibuat dan disimpan dengan memilih opsi 'Write ERC report'. Ekstensi berkas
untuk laporan ERC adalah .erc . Berikut adalah contoh dari berkas laporan ERC.

ERC control (4/1/1997-14:16:4) 
 
***** Sheet 1 (INTERFACE UNIVERSAL) 
ERC: Warning Pin input Unconnected @ 8.450, 2.350 
ERC: Warning passive Pin Unconnected @ 8.450, 1.950 
ERC: Warning: BiDir Pin connected to power Pin (Net 6) @ 10.100, 3.300 
ERC: Warning: Power Pin connected to BiDir Pin (Net 6) @ 4.950, 1.400 
 
>> Errors ERC: 4
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Membuat Netlist
Gambaran Umum
Netlist adalah sebuah berkas yang berisi penjelasan koneksi elektrikal antar simbol. Koneksi tersebut
disebut sebagai net. Pada berkas Netlist, Anda akan menemukan:

Daftar simbol

Daftar koneksi (net) antar simbol.

Ada beragam format Netlist yang berbeda. Terkadang, daftar simbol dan daftar net dibuat menjadi dua
berkas yang terpisah. Netlist ini sangat penting dalam penggunaan perangkat lunak pembuat skematik,
karena Netlist akan menjadi penghubung dengan perangkat lunak CAD elektronik lainnya seperti:

Perangkat lunak pembuat tata letak PCB.

Simulator skematik dan sinyal elektrikal.

Kompiler CPLD (dan IC terprogram lainnya).

The KiCad Schematic Editor supports several netlist formats.

Format PCBNEW (papan PCB).

Format PCB2 ORCAD (papan PCB).

Format CADSTAR (papan PCB).

Format Spice, untuk berbagai simulator (format Spice juga digunakan untuk berbagai simulator lain).

Format-format Netlist
Pilih ikon Netlist icon untuk membuka kotak dialog pembuatan Netlist.

Tab Pcbnew

Tab Spice
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Anda dapat memilih format yang diinginkan dengan memilih tab yang sesuai. Pada format Spice, Anda dapat
membuat Netlist dengan menggunakan nama net yang akan menjadikan berkas SPICE lebih mudah dibaca,
atau menggunakan nomor net yang digunakan oleh Spice versi lama. Setelah menekan tombol Netlist, Anda
harus menuliskan nama Netlist yang diinginkan.

NOTE Pembuatan Netlist bisa memerlukan waktu hingga beberapa menit untuk skematik yang
besar.

Contoh Netlist
Contoh berikut ini adalah sebuah desain skematik menggunakan pustaka PSPICE:

Contoh berkas Netlist PCBNEW:
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# Eeschema Netlist Version 1.0 generee le 21/1/1997-16:51:15 
( 
(32E35B76 $noname C2 1NF {Lib=C} 
(1 0) 
(2 VOUT_1) 
) 
(32CFC454 $noname V2 AC_0.1 {Lib=VSOURCE} 
(1 N-000003) 
(2 0) 
) 
(32CFC413 $noname C1 1UF {Lib=C} 
(1 INPUT_1) 
(2 N-000003) 
) 
(32CFC337 $noname V1 DC_12V {Lib=VSOURCE} 
(1 +12V) 
(2 0) 
) 
(32CFC293 $noname R2 10K {Lib=R} 
(1 INPUT_1) 
(2 0) 
) 
(32CFC288 $noname R6 22K {Lib=R} 
(1 +12V) 
(2 INPUT_1) 
) 
(32CFC27F $noname R5 22K {Lib=R} 
(1 +12V) 
(2 N-000008) 
) 
(32CFC277 $noname R1 10K {Lib=R} 
(1 N-000008) 
(2 0) 
) 
(32CFC25A $noname R7 470 {Lib=R} 
(1 EMET_1) 
(2 0) 
) 
(32CFC254 $noname R4 1K {Lib=R} 
(1 +12V) 
(2 VOUT_1) 
) 
(32CFC24C $noname R3 1K {Lib=R} 
(1 +12V) 
(2 N-000006) 
) 
(32CFC230 $noname Q2 Q2N2222 {Lib=NPN} 
(1 VOUT_1) 
(2 N-000008) 
(3 EMET_1) 
) 
(32CFC227 $noname Q1 Q2N2222 {Lib=NPN} 
(1 N-000006) 
(2 INPUT_1) 
(3 EMET_1) 
) 
) 
# End
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Berikut adalah Netlist dalam format PSPICE:

Catatan Mengenai Netlist

Penamaan Netlist
Kebanyakan perangkat lunak yang menggunakan Netlist tidak menerima penggunaan spasi pada nama
komponen, pin, net, atau informasi-informasi lainnya. Hindari penggunaan spasi pada label, atau atribut
nama atau nilai pada komponen atau pin-pinnya, untuk memastikan kompatibilitas maksimum.

In the same way, special characters other than letters and numbers can cause problems. Note that this
limitation is not related to KiCad, but to the netlist formats that can then become untranslatable to software
that uses netlist files.

Netlist PSPICE
Untuk simulator Pspice, Anda harus memasukkan beberapa baris perintah pada Netlist itu sendiri (.PROBE,
.AC, dsb).

Setiap baris teks yang ada pada diagram skematik yang dimulai dari kata kunci -pspice atau -gnucap akan
dimasukkan (tanpa kata kunci) pada bagian atas Netlist.

* Eeschema Netlist Version 1.1 (Spice format) creation date: 18/6/2008-08:38:03 
 
.model Q2N2222 npn (bf=200) 
.AC 10 1Meg \*1.2 
.DC V1 10 12 0.5 
 
 
R12   /VOUT N-000003 22K 
R11   +12V N-000003 100 
L1   N-000003 /VOUT 100mH 
R10   N-000005 N-000004 220 
C3   N-000005 0 10uF 
C2   N-000009 0 1nF 
R8   N-000004 0 2.2K 
Q3   /VOUT N-000009 N-000004 N-000004 Q2N2222 
V2   N-000008 0 AC 0.1 
C1   /VIN N-000008 1UF 
V1   +12V 0 DC 12V 
R2   /VIN 0 10K 
R6   +12V /VIN 22K 
R5   +12V N-000012 22K 
R1   N-000012 0 10K 
R7   N-000007 0 470 
R4   +12V N-000009 1K 
R3   +12V N-000010 1K 
Q2   N-000009 N-000012 N-000007 N-000007 Q2N2222 
Q1   N-000010 /VIN N-000007 N-000007 Q2N2222 
 
.print ac v(vout) 
.plot ac v(nodes) (-1,5) 
 
.end
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Setiap baris teks yang ada pada diagram skematik yang dimulai dari kata kunci +pspice atau +gnucap akan
dimasukkan (tanpa kata kunci) pada bagian akhir netlist.

Berikut adalah contoh penggunaan beberapa teks satu baris dan satu teks dengan lebih dari satu baris:

Sebagai contoh, jika Anda menuliskan teks berikut (jangan menggunakan label!):

-PSPICE .PROBE

Sebuah baris .PROBE akan dimasukkan ke dalam Netlist.

Pada contoh sebelumnya, ada tiga baris yang dimasukkan di awal Netlist, dan dua di akhir Netlist dengan
teknik ini.

Jika Anda menggunakan teks dengan lebih dari satu baris, kata kunci +pspice atau +gnucap hanya
diperlukan satu kali saja:

+PSPICE .model NPN NPN 
.model PNP PNP 
.lib C:\Program Files\LTC\LTspiceIV\lib\cmp\standard.bjt 
.backanno

menghasilkan empat baris:

.model NPN NPN 

.model PNP PNP 
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.lib C:\Program Files\LTC\LTspiceIV\lib\cmp\standard.bjt 

.backanno

Perhatikan juga bahwa net GND harus dinamai 0 (zero) untuk Pspice.

Format Lain
For other netlist formats you can add netlist converters in the form of plugins. These converters are
automatically launched by KiCad. Chapter 14 gives some explanations and examples of converters.

A converter is a text file (xsl format) but one can use other languages like Python. When using the xsl
format, a tool (xsltproc.exe or xsltproc) read the intermediate file created by KiCad, and the converter file to
create the output file. In this case, the converter file (a sheet style) is very small and very easy to write.

Memulai Kotak Dialog
Anda bisa menambahkan sebuah plugin Netlist melalui tombol 'Add Plugin'.

Berikut tampilan pengaturan plugin PadsPcb:

Pengaturan ini membutuhkan:

Sebuah judul (sebagai contoh, nama dari format Netlist).

Plugin yang akan dijalankan.

Ketika Netlist telah berhasil dibuat:

1. KiCad creates an intermediate file *.tmp, for example test.tmp.

2. KiCad runs the plug-in, which reads test.tmp and creates test.net.
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Format Baris Perintah
Berikut adalah contoh penggunaan xsltproc.exe  sebagai alat untuk mengkonversi berkas .xsl , dan
sebuah berkas netlist_form_pads-pcb.xsl  sebagai gaya lembar kerja konverter:

f:/kicad/bin/xsltproc.exe -o %O.net f:/kicad/bin/plugins/netlist_form_pads-pcb.xsl %I

Dengan:

f:/kicad/bin/xsltproc.exe A tool to read and convert xsl file

-o %O.net Output file: %O will define the output file.

f:/kicad/bin/plugins/netlist_form_pads-pcb.xsl File name converter (a sheet style, xsl
format).

%I Will be replaced by the intermediate file
created by KiCad (*.tmp).

Untuk sebuah skematik dengan nama test.sch , baris perintahnya adalah:

f:/kicad/bin/xsltproc.exe -o test.net f:/kicad/bin/plugins/netlist_form_pads-pcb.xsl test.tmp.

Konverter dan Gaya Lembar Kerja (Plugin)
Ini adalah perangkat lunak yang sangat sederhana, karena tugasnya hanya untuk mengkonversi sebuah
berkas teks masukan (berkas teks antara) menjadi berkas teks yang lain. Lebih lanjut lagi, dari berkas teks
antara, Anda dapat membuat sebuah daftar BOM.

Ketika menggunakan xsltproc  sebagai konverter, hanya gaya lembar kerja yang akan dibuat.

Format Berkas Netlist Antara
Lihat Bab 14 untuk mendapatkan penjelasan lebih mengenai xsltproc , penjelasan mengenai format berkas
antara, dan beberapa contoh dari gaya lembar kerja untuk konverter.
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Plot dan Cetak
Pengenalan
Anda bisa mengakses perintah cetak dan plot melalui menu 'File'.

Format keluaran yang didukung adalah Postscript, PDF, SVG, DXF, dan HPGL. Anda juga bisa mencetak
secara langsung ke mesin pencetak Anda.

Perintah Pencetak Umum
'Plot Current Page'

Mencetak hanya satu berkas untuk lembar kerja yang saat ini dibuka.

'Plot All Pages'

Mencetak plot untuk keseluruhan hirarki (akan dibuat satu berkas cetak untuk setiap lembar kerja).

Plot dalam Format Postscript
Perintah berikut akan menghasilkan berkas PostScript.



81

Nama berkas yang dihasilkan akan menggunakan nama lembar kerja dengan ekstensi .ps . Anda bisa
menonaktifkan opsi "'Plot border and title block'". Hal ini berguna jika Anda ingin membuat sebuah berkas
Postscript sebagai enkapsulasi (format .eps ) yang kadang digunakan untuk memasukkan sebuah diagram
ke dalam perangkat lunak pengolah kata. Kotak 'Messages' akan menampilkan nama berkas yang berhasil
dibuat.

Plot dalam Format PDF

Anda bisa membuat berkas plot menggunakan format PDF. Nama berkas yang dihasilkan akan
menggunakan nama lembar kerja, dengan ekstensi .pdf .
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Plot dalam Format SVG

Anda bisa membuat berkas plot menggunakan format vektor SVG. Nama berkas yang dihasilkan akan
menggunakan nama lembar kerja, dengan ekstensi .svg .

Plot dalam Format DXF

Anda bisa membuat berkas plot menggunakan format DXF. Nama berkas yang dihasilkan akan
menggunakan nama lembar kerja dengan ekstensi .dxf .

Plot dalam Format HPGL
Perintah ini akan menghasilkan sebuah berkas HPGL. Dalam format ini, Anda dapat menentukan:

Ukuran halaman.

Pangkal halaman (origin).
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Lebar pena (dalam mm).

Berikut tampilan kotak dialog pengaturan plotter:

Nama berkas yang dihasilkan akan menggunakan nama lembar kerja dengan ekstensi .plt .

Pemilihan Ukuran Lembar Kerja
Umumnya, ukuran halaman akan menyesuaikan ukuran lembar kerja. Pada kasus ini, akan digunakan
ukuran lembar kerja yang dipilih pada pengaturan blok judul, dan skala yang dipilih adalah 1. Jika dipilih
ukuran lembar kerja yang lain (A4 dengan A0, atau A dengan E), maka skala akan diatur secara otomatis
untuk mengisi halaman.

Pengaturan Offset
Untuk semua ukuran standar, Anda dapat mengatur offset untuk memposisikan gambar seakurat mungkin
di posisi tengah. Karena mesin plotter memiliki titik pangkal (origin) di tengah atau di sudut kiri bawah
lembar kerja, kita perlu mengatur offset agar hasil plot sesuai keinginan kita.

Secara umum:

Untuk mesin plotter yang memiliki titik pangkal di tengah lembar kerja, maka offset harus bernilai
negatif dan diatur setengah dari ukuran lembar kerja.

Untuk mesin plotter yang memiliki titik pangkal di sudut kiri bawah lembar kerja, maka offset harus
bernilai 0.

Untuk mengatur offset:

Pilih ukuran lembar kerja.

Atur offset X dan offset Y.

Klik untuk menerapkan pengaturan.



84

Mencetak di Kertas
This command, available via the icon , allows you to visualize and generate design files for the standard

printer.

Opsi "'Print sheet reference and title block'" akan mengaktifkan atau menonaktifkan referensi lembar kerja
dan blok judul.

Opsi "'Print in black and white'" akan mengatur hasil cetak dengan warna monokrom. Opsi ini diperlukan
jika Anda menggunakan mesin cetak laser hitam putih, karena warna selain itu akan dicetak secara buram
atau abu-abu, sehingga terkadang sulit dibaca.
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Symbol Editor
Informasi Umum
A symbol is a schematic element which contains a graphical representation, electrical connections, and text
fields describing the symbol. Symbols used in a schematic are stored in symbol libraries. KiCad provides a
symbol editing tool that allows you to create libraries, add, delete or transfer symbols between libraries,
export symbols to files, and import symbols from files. The symbol editing tool provides a simple way to
manage symbols and symbol libraries.

Tentang Pustaka Simbol
Suatu pustaka simbol memiliki satu atau lebih simbol. Secara umum, simbol dikelompokkan berdasarkan
fungsi, jenis, dan/atau manufaktur.

Sebuah simbol terdiri dari:

Graphical items (lines, circles, arcs, text, etc.) that determine how symbol looks in a schematic.

Pins which have both graphic properties (line, clock, inverted, low level active, etc.) and electrical
properties (input, output, bidirectional, etc.) used by the Electrical Rules Check (ERC) tool.

Atribut-atribut seperti referensi, nilai, nama footprint yang terkait untuk desain PCB, dsb.

Symbols can be derived from another symbol in the same library. Derived symbols share the base symbol’s
graphical shape and pin definitions, but can override the base symbol’s property fields (value, footprint,
footprint filters, datasheet, description, etc.). Derived symbols can be used to define symbols that are similar
to a base part. For example, 74LS00, 74HC00, and 7437 symbols could all be derived from a 7400 symbol. In
previous versions of KiCad, derived symbols were referred to as aliases.

Desain simbol yang baik memerlukan hal-hal sebagai berikut:

Menentukan apakah simbol perlu dibuat dalam bentuk lebih dari satu bagian.

Defining if the symbol has an alternate body style (also known as a De Morgan representation).

Membuat desain representasi simbolis menggunakan garis, persegi, lingkaran, poligon, dan teks.

Menambahkan pin dengan mendefinisikan secara teliti setiap elemen grafis pin, nama, penomoran, dan
properti elektrikal (input, output, tri-state, power port, dsb).

Determining if the symbol should be derived from another symbol with the same graphical design and
pin definition.

Menambahkan atribut opsional seperti nama footprint yang digunakan oleh perangkat lunak desain PCB,
dan/atau menentukan bagian-bagian yang perlu ditampilkan.

Mendokumentasikan simbol dengan menambahkan deskripsi dan tautan ke lembar data, dsb.

Menyimpan ke dalam pustaka yang diinginkan.

Tentang Editor Pustaka Simbol
Tampilan jendela utama editor pustaka simbol ditunjukkan pada gambar di bawah ini. Editor ini terdiri dari
tiga bilah alat yang digunakan untuk mengakses secara cepat fitur-fitur umum, dan satu area untuk
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melihat/mengedit simbol. Tidak semua perintah tersedia pada bilah alat, namun dapat diakses melalui
menu.

Bilah Alat Utama
The main tool bar is located at the top of the main window. It consists of the undo/redo commands, zoom
commands, symbol properties dialogs, and unit/representation management controls.
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Create a new symbol in the selected library.

Save the currently selected library. All modified symbols in the library will be saved.

Undo last edit.

Redo last undo.

Refresh display.

Zoom in.

Zoom out.

Zoom to fit symbol in display.

Zoom to fit selection.

Rotate counter-clockwise.

Rotate clockwise.

Mirror horizontally.

Mirror vertically.

Edit the current symbol properties.

Edit the symbol’s pins in a tablular interface.

Open the symbol’s datasheet. The button will be disabled if no datasheet is defined
for the current symbol.

Test the current symbol for design errors.

Select the normal body style. The button is disabled if the current symbol does not
have an alternate body style.

Select the alternate body style. The button is disabled if the current symbol does not
have an alternate body style.

Select the unit to display. The drop down control will be disabled if the current
symbol is not derived from a symbol with multiple units.

Enable synchronized pins edit mode. When this mode is enabled, any pin
modifications are propagated to all other symbol units. Pin number changes are not
propagated. This mode is automatically enabled for symbols with multiple
interchangable units and cannot be enabled for symbols with only one unit.



88

Bilah Alat Elemen
The vertical toolbar located on the right hand side of the main window allows you to place all of the
elements required to design a symbol.

Select tool. Right-clicking with the select tool opens the context menu for the object under the
cursor. Left-clicking with the select tool displays the attributes of the object under the cursor
in the message panel at the bottom of the main window. Double-left-clicking with the select
tool will open the properties dialog for the object under the cursor.

Pin tool. Left-click to add a new pin.

Graphical text tool. Left-click to add a new graphical text item.

Rectangle tool. Left-click to begin drawing the first corner of a graphical rectangle. Left-click
again to place the opposite corner of the rectangle.

Circle tool. Left-click to begin drawing a new graphical circle from the center. Left-click again
to define the radius of the circle.

Arc tool. Left-click to begin drawing a new graphical arc item from the first arc end point. Left-
click again to define the second arc end point. Adjust the radius by dragging the arc center
point.

Connected line tool. Left-click to begin drawing a new graphical line item in the current
symbol. Left-click for each additional connected line. Double-left-click to complete the line.

Anchor tool. Left-click to set the anchor position of the symbol.

Delete tool. Left-click to delete an object from the current symbol.

Bilah Alat Opsi
The vertical tool bar located on the left hand side of the main window allows you to set some of the editor
drawing options.

Toggle grid visibility on and off.

Set units to inches.

Set units to mils (0.001 inch).

Set units to millimeters.

Toggle full screen cursor on and off.

Toggle display of pin electrical types.

Toggle display of libraries and symbols.
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Pemilihan dan Pemeliharaan Pustaka
The selection of the current library is possible via the  icon which shows you all available libraries and

allows you to select one. When a symbol is loaded or saved, it will be put in this library. The library name of
a symbol is the contents of its Value  field.

Memilih dan Menyimpan Simbol

Pemilihan Simbol
Clicking the  icon on the left tool bar toggles the treeview of libraries and symbols. Clicking on a symbol

opens that symbol.

NOTE

Some symbols are derived from other symbols. Derived symbol names are displayed in
italics in the treeview. If a derived symbol is opened, its symbol graphics will not be
editable. Its symbol fields will be editable as normal. To edit the graphics of a base symbol
and all of its derived symbols, open the base symbol.

Menyimpan Simbol
After modification, a symbol can be saved in the current library or a different library.

To save the modified symbol in the current library, click the  icon. The modifications will be written to

the existing symbol.

NOTE Saving a modified symbol also saves all other modified symbols in the same library.

To save the symbol changes to a new symbol, click File → Save As… . The symbol can be saved in the current
library or a different library. A new name can be set for the symbol.

To create a new file containing only the current symbol, click File → Export → Symbol… . This file will be a
standard library file which will contain only one symbol.

Membuat Simbol Pustaka

Membuat Simbol Baru
A new symbol can be created by clicking the  icon. You will be asked for a number of symbol properties.

A symbol name (this name is used as the default value for the Value  field in the schematic editor)

An optional base symbol to derive the new symbol from. The new symbol will use the base symbol’s
graphical shape and pin configuration, but other symbol information can be modified in the derived
symbol. The base symbol must be in the same library as the new derived symbol.

The reference designator prefix ( U , C , R… ).

The number of units per package, and whether those units are interchangeable (for example a 7400 is
made of 4 units per package).

If an alternate body style (sometimes referred to as a "De Morgan equivalent") is desired.

Whether the symbol is a power symbol. Power symbols appear in the "Add Power Port" dialog in the
Schematic editor, their Value  fields are not editable in the schematic, they cannot be assigned a
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footprint and they are not added to the PCB, and they are not included in the bill of materials.

Whether the symbol should be excluded from the bill of materials.

Whether the symbol should be excluded from the PCB.

There are also several graphical options.

The offset between the end of each pin and its pin name.

Whether the pin number and pin name should be displayed.

Whether the pin names should be displayed alongside the pins or at the ends of the pins inside the
symbol body.

These properties can also be changed later in the Symbol Properties window.

Simbol yang baru akan dibuat menggunakan properti di atas, dan akan muncul pada layar editor seperti
gambar di bawah ini.
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The blue cross in the center is the symbol anchor, which specifies the symbol origin i.e. the coordinates (0, 0).
The anchor can be repositioned by selecting the  icon and clicking on the new desired anchor position.

Membuat Simbol dari Simbol yang Lain
Terkadang, simbol yang ingin Anda buat berbentuk mirip dengan simbol yang sudah ada di pustaka. Anda
dapat memuat dan memodifikasi simbol yang sudah ada dengan mudah.

Muat simbol yang akan digunakan sebagai titik mulai.

Save a new copy of the symbol using File → Save As… . The Save As dialog will prompt for a name for the
new symbol and the library to save it in.

Edit simbol baru sesuai keinginan Anda.

Save the modified symbol.

Properti Simbol
Symbol properties are set when the symbol is created but they can be modified at any point. To change the

symbol properties, click on the  icon to show the dialog below.
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It is important to correctly set the number of units per package and the alternate symbolic representation, if
enabled, because when pins are edited or created the corresponding pins for each unit will be affected. If
you change the number of units per package after pin creation and editing, there will be additional work to
specify the pins and graphics for the new unit. Nevertheless, it is possible to modify these properties at any
time.

The graphic options "Show pin number" and "Show pin name" define the visibility of the pin number and pin
name text. The option "Place pin names inside" defines the pin name position relative to the pin body. The
pin names will be displayed inside the symbol outline if the option is checked. In this case the "Pin Name
Position Offset" property defines the shift of the text away from the body end of the pin. A value from 0.02
to 0.05 inches is usually reasonable.

Contoh di bawah ini menampilkan sebuah simbol dengan opsi "'Place pin name inside'" dicentang.
Perhatikan posisi dari nama dan nomor pin.
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Symbol Name, Description, and Keywords
The symbol’s name is the same as the Value  field. When the symbol name is changed the value also changes,
and vice versa. The symbol’s name in the library also changes accordingly.

The symbol description should contain a brief description of the component, such as the component
function, distinguishing features, and package options. The keywords should contain additional terms
related to the component. Keywords are used primarily to assist in searching for the symbol.
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A symbol’s name, description, and keywords are all used when searching for symbols in the Symbol Editor
and Add a Symbol dialog. The description and keywords are displayed in the Symbol Library Browser and
Add a Symbol dialog.

Footprint Filters
The footprint filters tab is used to define which footprints are appropriate to use with the symbol. The
filters can be applied in the Footprint Assignment tool so that only appropriate footprints are displayed for
each symbol.

Multiple footprint filters can be defined. Footprints that match any of the filters will be displayed; if no
filters are defined, then all footprints will be displayed.

Filters can use wildcards: *  matches any number of characters, including zero, and ?  matches zero or one
characters. For example, SOIC-*  would match the SOIC-8_3.9x4.9mm_P1.27mm  footprint as well as any
other footprint beginning with SOIC- . The filter SOT?23  matches SOT23  as well as SOT-23 .
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Simbol dengan Representasi Simbolis Alternatif
If the symbol has an alternate body style defined, one body style must be selected for editing at a time. To
edit the normal representation, click the  icon.

To edit the alternate representation, click on the  icon. Use the  dropdown shown below

to select the unit you wish to edit.



96

Elemen Grafis
Graphical elements create the visual representation of a symbol and contain no electrical connection
information. Graphical elements are created with the following tools:

Garis dan poligon, didefinisikan oleh titik awal dan titik akhir.

Persegi, didefinisikan oleh dua sudut diagonal.

Lingkaran, didefinisikan oleh titik tengah dan radius.

Busur, didefinisikan oleh titik mulai dan titik akhir busur dan titik tengahnya. Busur bisa memiliki sudut
0° hingga 180°.

Bilah alat vertikal di sebelah kanan jendela utama berguna untuk meletakkan semua elemen grafis yang
diperlukan untuk mendesain tampilan sebuah simbol.

Keanggotaan Elemen Grafis
Setiap elemen grafis (garis, busur, lingkaran, dsb) dapat didefinisikan sebagai bentuk umum untuk
keseluruhan bagian dan/atau gaya bentuk atau spesifik untuk bagian dan/atau gaya bentuk tertentu. Opsi-
opsi elemen dapat diakses dengan klik-kanan pada elemen untuk menampilkan menu konteks elemen yang
dipilih. Gambar di bawah menampilkan menu konteks untuk elemen garis.
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Anda juga bisa melakukan klik-ganda pada sebuah elemen untuk mengubah propertinya. Gambar di bawah
menampilkan dialog properti untuk elemen poligon.
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Properti dari suatu elemen grafis antara lain:

"Line width" defines the width of the element’s line in the current drawing units.

"Fill Style" determines if the shape defined by the graphical element is to be drawn unfilled, background
filled, or foreground filled.

"Common to all units in symbol" determines if the graphical element is drawn for each unit in symbol
with more than one unit per package or if the graphical element is only drawn for the current unit.

"Common to all body styles (De Morgan)" determines if the graphical element is drawn for each symbolic
representation in symbols with an alternate body style or if the graphical element is only drawn for the
current body style.

Elemen Teks Grafis
The  icon allows for the creation of graphical text. Graphical text is automatically oriented to be

readable, even when the symbol is mirrored. Please note that graphical text items are not the same as
symbol fields.

Simbol dengan Beberapa Bagian dan Gaya Bentuk Alternatif
Symbols can have up to two body styles (a standard symbol and an alternate symbol often referred to as a
"De Morgan equivalent") and/or have more than one unit per package (logic gates for example). Some
symbols can have more than one unit per package each with different symbols and pin configurations.

Consider for instance a relay with two switches, which can be designed as a symbol with three different
units: a coil, switch 1, and switch 2. Designing a symbol with multiple units per package and/or alternate
body styles is very flexible. A pin or a body symbol item can be common to all units or specific to a given unit
or they can be common to both symbolic representation so are specific to a given symbol representation.

By default, pins are specific to a unit and body style. When a pin is common to all units or all body styles, it
only needs to be created once. This is also the case for the body style graphic shapes and text, which may be
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common to each unit, but typically are specific to each body style).

Example of a Symbol With Multiple Noninterchangeable Units
For an example of a symbol with multiple units that are not interchangeable, consider a relay with 3 units
per package: a coil, switch 1, and switch 2.

The three units are not all the same, so "All units are interchangeable" should be deselected in the Symbol
Properties dialog. Alternatively, this option could have been specified when the symbol was initially created.
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Unit A

Unit B

Unit C

Unit A does not have the same symbol and pin layout as Units B and C, so the units are not interchangeable.

NOTE

"Synchronized Pins Edit Mode" can be enabled by clicking the  icon. In this mode, pin
modifications are propagated between symbol units; changes made in one unit will be
reflected in the other units as well. When this mode is disabled, pin changes made in one
unit do not affect other units. This mode is enabled automatically when "All units are
interchangeable" is checked, but it can be disabled. The mode cannot be enabled when "All
units are interchangeable" is unchecked or when the symbol only has one unit.
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Elemen Simbolis Grafis
Shown below are properties for a graphic body element. In the relay example above, the three units have
different symbolic representations. Therefore, each unit was created separately and the graphical body
elements have the "Common to all units in symbol" setting disabled.

Membuat dan Mengedit Pin
You can click on the  icon to create and insert a pin. The editing of all pin properties is done by double-

clicking on the pin or right-clicking on the pin to open the pin context menu. Pins must be created carefully,
because any error will have consequences on the PCB design. Any pin already placed can be edited, deleted,
and/or moved.

Tentang Pin
A pin is defined by its graphical representation, its name and its number. The pin’s name and number can
contain letters, numbers, and symbols, but not spaces. For the Electrical Rules Check (ERC) tool to be useful,
the pin’s electrical type (input, output, tri-state… ) must also be defined correctly. If this type is not defined
properly, the schematic ERC check results may be invalid.

Catatan penting:

Symbol pins are matched to footprint pads by number. The pin number in the symbol must match the
corresponding pad number in the footprint.

Do not use spaces in pin names and numbers. Spaces will be automatically replaced with underscores
( _ ).

To define a pin name with an inverted signal (overline) use the ~  (tilde) character followed by the text
to invert in braces. For example ~{FO}O  would display FO O.

If the pin name is empty, the pin is considered unnamed.

Pin names can be repeated in a symbol.
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Pin numbers must be unique in a symbol.

Properti Pin

Kotak dialog properti pin digunakan untuk mengedit karakteristik dari sebuah pin. Kotak dialog ini akan
muncul secara otomatis ketika Anda membuat sebuah pin atau melakukan klik-ganda pada pin yang sudah
ada. Kotak dialog ini dapat digunakan untuk mengubah:

The pin name and text size.

The pin number and text size.

The pin length.

The pin electrical type and graphical style.

Keanggotaan pada bagian dan representasi alternatif.

Pin visibility.

Alternate pin definitions.

Pin Graphic Styles
Shown in the figure below are the different pin graphic styles. The choice of graphic style does not have any
influence on the pin’s electrical type.
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Tipe Elektrikal Pin
Choosing the correct electrical type is important for the schematic ERC tool. ERC will check that pins are
connected appropriately, for example ensuring that input pins are driven and power inputs receive power
from an appropriate source.
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Pin Type Description

Input A pin which is exclusively an input.

Output A pin which is exclusively an output.

Bidirectional A pin that can be either an input or an output, such as a microcontroller data
bus pin.

Tri-state A three state output pin (high, low, or high impedance)

Passive A passive symbol pin: resistors, connectors, etc.

Free A pin that can be freely connected to any other pin without electrical concerns.

Unspecified A pin for which the ERC check does not matter.

Power input A symbol’s power pin. As a special case, power input pins that are marked
invisible are automatically connected to the net with the same name. See the
Power Ports section for more information.

Power output A pin that provides power to other pins, such as a regulator output.

Open collector An open collector logic output.

Open emitter An open emitter logic output.

Unconnected A pin that should not be connected to anything.

Pushing Pin Properties to Other Pins
You can apply the length, name size, or number size of a pin to the other pins in the symbol by right clicking
the pin and selecting Push Pin Length, Push Pin Name Size, or Push Pin Number Size, respectively.
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Mendefinisikan Pin untuk Banyak Bagian dan Representasi Simbolis
Alternatif
Symbols with multiple units and/or graphical representations are particularly problematic when creating
and editing pins. The majority of pins are specific to each symbol unit (because each unit has a different set
of pins) and to each body style (because the form and position is different between the normal body style
and the alternate form).

The symbol library editor allows the simultaneous creation of pins. By default, changes made to a pin are
made for all units of a multiple unit symbol and to both representations for symbols with an alternate
symbolic representation. The only exception to this is the pin’s graphical type and name, which remain
unlinked between symbol units and body styles. This dependency was established to allow for easier pin
creation and editing in most cases. This dependency can be disabled by toggling the  icon on the main

tool bar. This will allow you to create pins for each unit and representation completely independently.

Pins can be common or specific to different units. Pins can also be common to both symbolic representations
or specific to each symbolic representation. When a pin is common to all units, it only has to drawn once.
Pins are set as common or specific in the pin properties dialog.

An example is the output pin in the 7400 quad dual input NAND gate. Since there are four units and two
symbolic representations, there are eight separate output pins defined in the symbol definition. When
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creating a new 7400 symbol, unit A of the normal symbolic representation will be shown in the library
editor. To edit the pin style in the alternate symbolic representation, it must first be enabled by clicking the 

 button on the tool bar. To edit the pin number for each unit, select the appropriate unit using the 

 drop down control.

Pin Table
Another way to edit pins is to use the Pin Table, which is accessible via the  icon. The Pin Table displays

all of the pins in the symbol and their properties in a table view, so it is useful for making bulk pin changes.

Any pin property can be edited by clicking on the appropriate cell. Pins can be added and removed with the 
 and  icons, respectively.

NOTE Columns of the pin table can be shown or hidden by right-clicking on the header row and
checking or unchecking additional columns. Some columns are hidden by default.

The screenshot below shows the pin table for a quad opamp.

Alternate Pin Definitions
Pins can have alternate pin definitions added to them. Alternate pin definitions allow a user to select a
different name, electrical type, and graphical style for a pin when the symbol has been placed in the
schematic. This can be used for pins that have multiple functions, such as microcontroller pins.

Alternate pin definitions are added in the Pin Properties dialog as shown below. Each alternate definition
contains a pin name, electrical type, and graphic style. This microcontroller pin has all of its peripheral
functions defined in the symbol as alternate pin names.
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Alternate pin definitions are selected in the Schematic Editor once the symbol has been placed in the
schematic. The alternate pin is assigned in the Alternate Pin Assignments tab of the Symbol Properties
dialog. Alternate definitions are selectable in the dropdown in the Alternate Assignment column.
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Atribut-atribut Simbol
All library symbols are defined with four default fields. The reference designator, value, footprint
assignment, and datasheet link fields are created whenever a symbol is created or copied. Only the reference
designator and value fields are required.

Symbols defined in libraries are typically defined with only these four default fields. Additional fields such
as vendor, part number, unit cost, etc. can be added to library symbols but generally this is done in the
schematic editor so the additional fields can be applied to all of the symbols in the schematic.

NOTE

A convenient way to create additional empty symbol fields is to use define field name
templates. Field name templates define empty fields that are added to each symbol when
it is inserted into the schematic. Field name templates can be defined globally (for all
schematics) in the Schematic Editor Preferences, or they can be defined locally (specific to
each project) in the Schematic Setup dialog.

Mengedit Atribut Simbol
Untuk mengedit atribut simbol yang sudah ada, klik-kanan pada teks atribut untuk menampilkan menu
konteks atribut seperti ditunjukkan pada gambar di bawah ini.
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To add new fields, delete optional fields, or edit existing fields, use the  icon on the main tool bar to open

the Symbol Properties dialog.

Fields are text information associated a the symbol. Do not confuse them with text in the graphic
representation of a symbol.

Catatan penting:

Modifying the Value  field changes the name of the symbol. The symbol’s name in the library will change
when the symbol is saved.

The Symbol Properties dialog must be used to edit a field that is empty or has the invisible attribute
enabled because such fields cannot be clicked on.

The footprint is defined as an absolute footprint using the LIBNAME:FOOTPRINTNAME  format where
LIBNAME  is the name of the footprint library defined in the footprint library table (see the "Footprint
Library Table" section in the PCB Editor manual) and FOOTPRINTNAME  is the name of the footprint in the
library LIBNAME .

Power Ports
Power ports, or power symbols, are conventionally used to label a wire as part of a power net, like VCC ,
+5V , or GND . In the schematic below, the +3.3V  and GND  symbols are power ports. In addition to acting as a
visual indicator that a net is a power rail, a power port will determine the name of the net it is attached to.
This is true even if there is another net label attached to the net; the net name determined by the power
symbol overrides any other net names.



110

It may be useful to place power symbols in a dedicated library. KiCad’s symbol library places power symbols
in the power  library, and users may create libraries to store their own power symbols. If the "Define as
power symbol" box is checked in a symbol’s properties, that symbol will appear in the Schematic Editor’s
"Add Power Port" dialog for convenient access.

Power symbols are handled and created the same way as normal symbols, but there are several additional
considerations described below. They consist of a graphical symbol and a pin of the type "Power input" that
is marked hidden.

Below is an example of a GND  power symbol.
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Creating a Power Port Symbol
Power Port symbols consist of a pin of type "Power input" that is marked invisible. Invisible power input
pins have a special property of automatically connecting to a net with the same name as the pin name. A net
that is wired to an invisible power input pin will therefore be named after the pin, even if there are other
net labels on the net. This connection is global.

NOTE
If the power symbol has the "Define as power symbol" property checked, the power input
pin does not need to be marked invisible. However, the convention is to make these pins
invisible anyway.
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Untuk membuat sebuah simbol power, lakukan langkah-langkah berikut:

Add a pin of type "Power input", with "Visible" unchecked, and the pin named according to the desired
net. Make the pin number 1 , the length 0 , and set the graphic style to "Line". The pin name establishes
the connection to the net; in this case the pin will automatically connect to the net GND . The pin number,
length, and line style do not matter electrically.

Place the pin on the symbol anchor.

Use the shape tools to draw the symbol graphics.

Set the symbol value. The symbol value does not matter electrically, but it is displayed in the schematic.
To eliminate confusion, it should match the pin name (which determines the connected net name).

Check the "Define as power symbol" box in Symbol Properties window. This makes the symbol appear in
the "Add Power Port" dialog, makes the Value  field read-only in the schematic, prevents the symbol
from being assigned a footprint, and excludes the symbol from the board, BOM, and netlists.

Set the symbol reference and uncheck the "Show" box. The reference text is not important except for the
first character, which should be # . For the power port shown above, the reference could be #GND .
Symbols with references that begin with #  are not added to the PCB, are not included in Bill of Materials
exports or netlists, and they cannot be assigned a footprint in the footprint assignment tool. If a power
port’s reference does not begin with # , the character will be inserted automatically when the annotation
or footprint assignment tools are run.

An easier method to create a new power port symbol is to use another symbol as a starting point, as
described earlier.
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NOTE When modifying an existing power port symbol, make sure to rename the pin name so
that the new symbol connects to the appropriate power net.
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Peramban Pustaka Simbol
Pengenalan
The Symbol Library Browser allows you to quickly examine the content of symbol libraries. The Symbol

Library Viewer can be accessed by clicking  icon on the main toolbar, View → Symbol Library

Browser… , or clicking Select With Browser in the "Choose Symbol" window.
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Viewlib - Tampilan Utama

Untuk memeriksa isi pustaka, pilih satu pustaka dari daftar pada panel sebelah kiri. Semua simbol pada
pustaka yang dipilih akan ditampilkan pada panel kedua. Pilh nama simbol untuk melihat simbol tersebut.

Bilah Alat Atas pada Peramban Pustaka Simbol
Bilah alat atas pada Peramban Pustaka Simbol ditampilkan pada gambar di bawah.

The available commands are:



116

Selection of the symbol which can be also selected in the displayed list.

Display previous symbol.

Display next symbol.

   Zoom tools.

 Selection of the representation (normal or alternate) if an alternate representation
exists.

Selection of the unit for symbols that contain multiple units.

If they exist, display the associated documents.

Close the browser and place the selected symbol in the schematic.
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Membuat Netlist dan Berkas BOM Kustom
Berkas Netlist Antara
BOM files and netlist files can be converted from an Intermediate netlist file created by KiCad.

Berkas ini menggunakan sintaks XML dan disebut sebagai Netlist antara. Netlist antara berisi sejumlah
besar data mengenai papan sirkuit Anda. Maka dari itu, berkas ini bisa digunakan pasca-pemrosesan untuk
membuat BOM atau berkas laporan lainnya.

Tergantung dari keluarannya (BOM atau Netlist), sejumlah berkas turunan dari Netlist antara akan
digunakan pasca-pemrosesan.

Contoh Skematik

Contoh Berkas Netlist Antara
Netlist antara (menggunakan sintaks XML) yang terkait dengan sirkuit di atas ditunjukkan seperti di bawah
ini.
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<?xml version="1.0" encoding="utf-8"?> 
<export version="D"> 
  <design> 
    <source>F:\kicad_aux\netlist_test\netlist_test.sch</source> 
    <date>29/08/2010 20:35:21</date> 
    <tool>eeschema (2010-08-28 BZR 2458)-unstable</tool> 
  </design> 
  <components> 
    <comp ref="P1"> 
      <value>CONN_4</value> 
      <libsource lib="conn" part="CONN_4"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E2141</tstamp> 
    </comp> 
    <comp ref="U2"> 
      <value>74LS74</value> 
      <libsource lib="74xx" part="74LS74"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E20BA</tstamp> 
    </comp> 
    <comp ref="U1"> 
      <value>74LS04</value> 
      <libsource lib="74xx" part="74LS04"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E20A6</tstamp> 
    </comp> 
    <comp ref="C1"> 
      <value>CP</value> 
      <libsource lib="device" part="CP"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E2094</tstamp> 
    </comp> 
    <comp ref="R1"> 
      <value>R</value> 
      <libsource lib="device" part="R"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E208A</tstamp> 
    </comp> 
  </components> 
  <libparts> 
    <libpart lib="device" part="C"> 
      <description>Condensateur non polarise</description> 
      <footprints> 
        <fp>SM*</fp> 
        <fp>C?</fp> 
        <fp>C1-1</fp> 
      </footprints> 
      <fields> 
        <field name="Reference">C</field> 
        <field name="Value">C</field> 
      </fields> 
      <pins> 
        <pin num="1" name="~" type="passive"/> 
        <pin num="2" name="~" type="passive"/> 
      </pins> 
    </libpart> 
    <libpart lib="device" part="R"> 
      <description>Resistance</description> 
      <footprints> 
        <fp>R?</fp> 
        <fp>SM0603</fp> 
        <fp>SM0805</fp> 
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Konversi ke Format Netlist yang Baru
Dengan menerapkan sebuah penyaring pasca-pemrosesan ke berkas Netlist antara, Anda bisa membuat
berkas-berkas Netlist asing, demikian pula berkas-berkas BOM. Karena proses konversi ini adalah
transformasi dari teks ke teks, penyaring pasca-pemrosesan dapat dibuat menggunakan Python, XSLT, atau
peralatan lainnya yang mampu mengolah masukan XML.

XSLT itself is an XML language very suitable for XML transformations. There is a free program called
xsltproc that you can download and install. The xsltproc program can be used to read the Intermediate XML
netlist input file, apply a style-sheet to transform the input, and save the results in an output file. Use of
xsltproc requires a style-sheet file using XSLT conventions. The full conversion process is handled by KiCad,
after it is configured once to run xsltproc in a specific way.

Pendekatan XSLT
Dokumen yang menjelaskan Transformasi XSL (XSLT) tersedia di alamat berikut:

http://www.w3.org/TR/xslt

Membuat Berkas Netlist Pads-Pcb
Format pads-pcb terdiri dari dua bagian.

Daftar footprint.

Daftar net : pengelompokan referensi pad berdasarkan net.

Berikut adalah sebuah stylesheet untuk mengkonversi berkas Netlist antara ke format Netlist pads-pcb:

http://www.w3.org/TR/xslt
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<?xml version="1.0" encoding="ISO-8859-1"?> 
<!--XSL style sheet to Eeschema Generic Netlist Format to PADS netlist format 
    Copyright (C) 2010, SoftPLC Corporation. 
    GPL v2. 
 
    How to use: 
        https://lists.launchpad.net/kicad-developers/msg05157.html 
--> 
 
<!DOCTYPE xsl:stylesheet [ 
  <!ENTITY nl  "&#xd;&#xa;"> <!--new line CR, LF --> 
]> 
 
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"> 
<xsl:output method="text" omit-xml-declaration="yes" indent="no"/> 
 
<xsl:template match="/export"> 
    <xsl:text>*PADS-PCB*&nl;*PART*&nl;</xsl:text> 
    <xsl:apply-templates select="components/comp"/> 
    <xsl:text>&nl;*NET*&nl;</xsl:text> 
    <xsl:apply-templates select="nets/net"/> 
    <xsl:text>*END*&nl;</xsl:text> 
</xsl:template> 
 
<!-- for each component --> 
<xsl:template match="comp"> 
    <xsl:text> </xsl:text> 
    <xsl:value-of select="@ref"/> 
    <xsl:text> </xsl:text> 
    <xsl:choose> 
        <xsl:when test = "footprint != '' "> 
            <xsl:apply-templates select="footprint"/> 
        </xsl:when> 
        <xsl:otherwise> 
            <xsl:text>unknown</xsl:text> 
        </xsl:otherwise> 
    </xsl:choose> 
    <xsl:text>&nl;</xsl:text> 
</xsl:template> 
 
<!-- for each net --> 
<xsl:template match="net"> 
    <!-- nets are output only if there is more than one pin in net --> 
    <xsl:if test="count(node)>1"> 
        <xsl:text>*SIGNAL* </xsl:text> 
        <xsl:choose> 
            <xsl:when test = "@name != '' "> 
                <xsl:value-of select="@name"/> 
            </xsl:when> 
            <xsl:otherwise> 
                <xsl:text>N-</xsl:text> 
                <xsl:value-of select="@code"/> 
            </xsl:otherwise> 
        </xsl:choose> 
        <xsl:text>&nl;</xsl:text> 
        <xsl:apply-templates select="node"/> 
    </xsl:if> 
</xsl:template> 
 
<!-- for each node --> 
<xsl:template match="node"> 
    <xsl:text> </xsl:text> 
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Dan berikut adalah berkas keluaran pads-pcb setelah menjalankan xsltproc:

Perintah untuk menjalankan konversi ini adalah:

Membuat Berkas Netlist Cadstar
Format Cadstar terdiri dari dua bagian.

Daftar footprint.

Daftar net : pengelompokan referensi pad berdasarkan net.

Berikut adalah berkas stylesheet untuk menjalankan konversi ini:

*PADS-PCB* 
*PART* 
P1 unknown 
U2 unknown 
U1 unknown 
C1 unknown 
R1 unknown 
*NET* 
*SIGNAL* GND 
U1.7 
C1.2 
U2.7 
P1.4 
*SIGNAL* VCC 
R1.1 
U1.14 
U2.4 
U2.1 
U2.14 
P1.1 
*SIGNAL* N-4 
U1.2 
U2.3 
*SIGNAL* /SIG_OUT 
P1.2 
U2.5 
U2.2 
*SIGNAL* /CLOCK_IN 
R1.2 
C1.1 
U1.1 
P1.3 
 
*END*

kicad\\bin\\xsltproc.exe -o test.net kicad\\bin\\plugins\\netlist_form_pads-pcb.xsl 
test.tmp



122

<?xml version="1.0" encoding="ISO-8859-1"?> 
<!--XSL style sheet to Eeschema Generic Netlist Format to CADSTAR netlist format 
    Copyright (C) 2010, Jean-Pierre Charras. 
    Copyright (C) 2010, SoftPLC Corporation. 
    GPL v2. 
 
<!DOCTYPE xsl:stylesheet [ 
  <!ENTITY nl  "&#xd;&#xa;"> <!--new line CR, LF --> 
]> 
 
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"> 
<xsl:output method="text" omit-xml-declaration="yes" indent="no"/> 
 
<!-- Netlist header --> 
<xsl:template match="/export"> 
    <xsl:text>.HEA&nl;</xsl:text> 
    <xsl:apply-templates select="design/date"/>  <!-- Generate line .TIM <time> --> 
    <xsl:apply-templates select="design/tool"/>  <!-- Generate line .APP <eeschema version> 
--> 
    <xsl:apply-templates select="components/comp"/>  <!-- Generate list of components --> 
    <xsl:text>&nl;&nl;</xsl:text> 
    <xsl:apply-templates select="nets/net"/>          <!-- Generate list of nets and 
connections --> 
    <xsl:text>&nl;.END&nl;</xsl:text> 
</xsl:template> 
 
 <!-- Generate line .TIM 20/08/2010 10:45:33 --> 
<xsl:template match="tool"> 
    <xsl:text>.APP "</xsl:text> 
    <xsl:apply-templates/> 
    <xsl:text>"&nl;</xsl:text> 
</xsl:template> 
 
 <!-- Generate line .APP "eeschema (2010-08-17 BZR 2450)-unstable" --> 
<xsl:template match="date"> 
    <xsl:text>.TIM </xsl:text> 
    <xsl:apply-templates/> 
    <xsl:text>&nl;</xsl:text> 
</xsl:template> 
 
<!-- for each component --> 
<xsl:template match="comp"> 
    <xsl:text>.ADD_COM </xsl:text> 
    <xsl:value-of select="@ref"/> 
    <xsl:text> </xsl:text> 
    <xsl:choose> 
        <xsl:when test = "value != '' "> 
            <xsl:text>"</xsl:text> <xsl:apply-templates select="value"/> <xsl:text>"
</xsl:text> 
        </xsl:when> 
        <xsl:otherwise> 
            <xsl:text>""</xsl:text> 
        </xsl:otherwise> 
    </xsl:choose> 
    <xsl:text>&nl;</xsl:text> 
</xsl:template> 
 
<!-- for each net --> 
<xsl:template match="net"> 
    <!-- nets are output only if there is more than one pin in net --> 
    <xsl:if test="count(node)>1"> 
    <xsl:variable name="netname"> 
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Berikut adalah berkas keluaran Cadstar.

Membuat Berkas Netlist OrcadPCB2
Format ini hanya memiliki satu bagian saja, yaitu daftar footprint. Setiap footprint berisi daftar pad dengan
referensi ke sebuah net.

Berikut adalah stylesheet untuk konversi ini:

.HEA 

.TIM 21/08/2010 08:12:08 

.APP "eeschema (2010-08-09 BZR 2439)-unstable" 

.ADD_COM P1 "CONN_4" 

.ADD_COM U2 "74LS74" 

.ADD_COM U1 "74LS04" 

.ADD_COM C1 "CP" 

.ADD_COM R1 "R" 
 
 
.ADD_TER U1.7 "GND" 
.TER     C1.2 
         U2.7 
         P1.4 
.ADD_TER R1.1 "VCC" 
.TER     U1.14 
         U2.4 
         U2.1 
         U2.14 
         P1.1 
.ADD_TER U1.2 "N-4" 
.TER     U2.3 
.ADD_TER P1.2 "/SIG_OUT" 
.TER     U2.5 
         U2.2 
.ADD_TER R1.2 "/CLOCK_IN" 
.TER     C1.1 
         U1.1 
         P1.3 
 
.END
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<?xml version="1.0" encoding="ISO-8859-1"?> 
<!--XSL style sheet to Eeschema Generic Netlist Format to CADSTAR netlist format 
    Copyright (C) 2010, SoftPLC Corporation. 
    GPL v2. 
 
    How to use: 
        https://lists.launchpad.net/kicad-developers/msg05157.html 
--> 
 
<!DOCTYPE xsl:stylesheet [ 
  <!ENTITY nl  "&#xd;&#xa;"> <!--new line CR, LF --> 
]> 
 
<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"> 
<xsl:output method="text" omit-xml-declaration="yes" indent="no"/> 
 
<!-- 
    Netlist header 
    Creates the entire netlist 
    (can be seen as equivalent to main function in C 
--> 
<xsl:template match="/export"> 
    <xsl:text>( { Eeschema Netlist Version 1.1  </xsl:text> 
    <!-- Generate line .TIM <time> --> 
<xsl:apply-templates select="design/date"/> 
<!-- Generate line eeschema version ... --> 
<xsl:apply-templates select="design/tool"/> 
<xsl:text>}&nl;</xsl:text> 
 
<!-- Generate the list of components --> 
<xsl:apply-templates select="components/comp"/>  <!-- Generate list of components --> 
 
<!-- end of file --> 
<xsl:text>)&nl;*&nl;</xsl:text> 
</xsl:template> 
 
<!-- 
    Generate id in header like "eeschema (2010-08-17 BZR 2450)-unstable" 
--> 
<xsl:template match="tool"> 
    <xsl:apply-templates/> 
</xsl:template> 
 
<!-- 
    Generate date in header like "20/08/2010 10:45:33" 
--> 
<xsl:template match="date"> 
    <xsl:apply-templates/> 
    <xsl:text>&nl;</xsl:text> 
</xsl:template> 
 
<!-- 
    This template read each component 
    (path = /export/components/comp) 
    creates lines: 
     ( 3EBF7DBD $noname U1 74LS125 
      ... pin list ... 
      ) 
    and calls "create_pin_list" template to build the pin list 
--> 
<xsl:template match="comp"> 
    <xsl:text> ( </xsl:text> 
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Berikut adalah berkas keluaran OrcadPCB2.

Netlist plugins interface
Intermediate Netlist converters can be automatically launched within the Schematic Editor.

Membuka Kotak Dialog Plugin
Kita bisa menambahkan sebuah tab antarmuka plugin Netlist yang baru dengan klik pada tombol 'Add
Plugin'

( { Eeschema Netlist Version 1.1  29/08/2010 21:07:51 
eeschema (2010-08-28 BZR 2458)-unstable} 
 ( 4C6E2141 $noname P1 CONN_4 
  (  1 VCC ) 
  (  2 /SIG_OUT ) 
  (  3 /CLOCK_IN ) 
  (  4 GND ) 
 ) 
 ( 4C6E20BA $noname U2 74LS74 
  (  1 VCC ) 
  (  2 /SIG_OUT ) 
  (  3 N-04 ) 
  (  4 VCC ) 
  (  5 /SIG_OUT ) 
  (  6 ? ) 
  (  7 GND ) 
  (  14 VCC ) 
 ) 
 ( 4C6E20A6 $noname U1 74LS04 
  (  1 /CLOCK_IN ) 
  (  2 N-04 ) 
  (  7 GND ) 
  (  14 VCC ) 
 ) 
 ( 4C6E2094 $noname C1 CP 
  (  1 /CLOCK_IN ) 
  (  2 GND ) 
 ) 
 ( 4C6E208A $noname R1 R 
  (  1 VCC ) 
  (  2 /CLOCK_IN ) 
 ) 
) 
*
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Berikut adalah bentuk data konfigurasi untuk tab PadsPcb:

Parameter Konfigurasi Plugin
The netlist plug-in configuration dialog requires the following information:

Judul: misalnya nama dari format Netlist.

Perintah untuk menjalankan konverter.

Setelah Anda menekan tombol Netlist, akan terjadi hal berikut ini:

1. KiCad creates an intermediate netlist file *.xml, for instance test.xml.

2. KiCad runs the plug-in by reading test.xml and creates test.net.

Membuat Berkas Netlist dengan Baris Perintah
Diasumsikan kita menggunakan program xsltproc.exe untuk menerapkan stylesheet ke berkas antara, maka
xsltproc.exe dieksekusi dengan perintah berikut:

xsltproc.exe -o <nama berkas keluaran> <nama berkas style-sheet> <berkas XML yang akan dikonversi>

Berikut baris perintah yang digunakan KiCad di sistem operasi Windows:

f:/kicad/bin/xsltproc.exe -o "%O" f:/kicad/bin/plugins/netlist_form_pads-pcb.xsl "%I"

Di sistem operasi Linux, baris perintahnya adalah:

xsltproc -o "%O" /usr/local/kicad/bin/plugins/netlist_form_pads-pcb.xsl "%I"

Where netlist_form_pads-pcb.xsl is the style-sheet that you are applying. Do not forget the double quotes
around the file names, this allows them to have spaces after the substitution by KiCad.

Baris perintah menerima parameter berikut untuk nama berkas:

Parameter yang didukung adalah:

%B ⇒ nama berkas dan path untuk berkas keluaran yang dipilih, tanpa path dan ekstensi.
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%I ⇒ nama berkas lengkap dan path dari berkas masukan sementara (berkas Netlist antara).

%O ⇒ nama berkas lengkap dan path untuk berkas keluaran yang dipilih.

%I akan diganti dengan nama berkas antara yang sesungguhnya.

%O akan diganti dengan nama berkas keluaran yang sesungguhnya.

Format Baris Perintah: Contoh xsltproc
Format baris perintah untuk xsltproc adalah sebagai berikut:

<path ke xsltproc> xsltproc <parameter xsltproc>

Penggunaan di Windows:

f:/kicad/bin/xsltproc.exe -o "%O" f:/kicad/bin/plugins/netlist_form_pads-pcb.xsl "%I"

Penggunaan di Linux:

xsltproc -o "%O" /usr/local/kicad/bin/plugins/netlist_form_pads-pcb.xsl "%I"

Contoh di atas mengasumsikan xsltproc terinstal pada komputer Windows dan semua berkas berada di
direktori kicad/bin .

Pembuatan Bill of Materials
Karena berkas Netlist antara berisi semua informasi mengenai komponen-komponen yang digunakan, maka
kita bisa membuat BOM berdasarkan berkas tersebut. Berikut adalah tampilan jendela pengaturan plugin
(di Linux) untuk membuat berkas Bill of Materials (BOM) kustom:

Path menuju berkas stylesheet bom2csv.xsl  tergantung pada sistem yang kita gunakan. Stylesheet XSLT
terbaik yang ada saat ini untuk pembuatan BOM adalah bom2csv.xsl. Anda bebas melakukan modifikasi
sesuai kebutuhan, dan jika Anda merasa hasil modifikasi tersebut akan bermanfaat untuk orang lain, Anda
bisa memasukkan hasil modifikasi tersebut sebagai bagian dari proyek KiCad.
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Format Baris Perintah: Contoh Skrip Python
Format baris perintah untuk Python adalah sebagai berikut:

python <nama berkas skrip> <nama berkas masukan> <nama berkas keluaran>

Penggunaan di Windows:

python *.exe f:/kicad/python/my_python_script.py "%I" "%O"

Penggunaan di Linux:

python /usr/local/kicad/python/my_python_script.py "%I" "%O"

Dengan asumsi Python telah terinstal di komputer Anda.

Struktur Netlist Antara
Contoh berikut ini menunjukkan format berkas Netlist.
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<?xml version="1.0" encoding="utf-8"?> 
<export version="D"> 
  <design> 
    <source>F:\kicad_aux\netlist_test\netlist_test.sch</source> 
    <date>29/08/2010 21:07:51</date> 
    <tool>eeschema (2010-08-28 BZR 2458)-unstable</tool> 
  </design> 
  <components> 
    <comp ref="P1"> 
      <value>CONN_4</value> 
      <libsource lib="conn" part="CONN_4"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E2141</tstamp> 
    </comp> 
    <comp ref="U2"> 
      <value>74LS74</value> 
      <libsource lib="74xx" part="74LS74"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E20BA</tstamp> 
    </comp> 
    <comp ref="U1"> 
      <value>74LS04</value> 
      <libsource lib="74xx" part="74LS04"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E20A6</tstamp> 
    </comp> 
    <comp ref="C1"> 
      <value>CP</value> 
      <libsource lib="device" part="CP"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E2094</tstamp> 
    <comp ref="R1"> 
      <value>R</value> 
      <libsource lib="device" part="R"/> 
      <sheetpath names="/" tstamps="/"/> 
      <tstamp>4C6E208A</tstamp> 
    </comp> 
  </components> 
  <libparts/> 
  <libraries/> 
  <nets> 
    <net code="1" name="GND"> 
      <node ref="U1" pin="7"/> 
      <node ref="C1" pin="2"/> 
      <node ref="U2" pin="7"/> 
      <node ref="P1" pin="4"/> 
    </net> 
    <net code="2" name="VCC"> 
      <node ref="R1" pin="1"/> 
      <node ref="U1" pin="14"/> 
      <node ref="U2" pin="4"/> 
      <node ref="U2" pin="1"/> 
      <node ref="U2" pin="14"/> 
      <node ref="P1" pin="1"/> 
    </net> 
    <net code="3" name=""> 
      <node ref="U2" pin="6"/> 
    </net> 
    <net code="4" name=""> 
      <node ref="U1" pin="2"/> 
      <node ref="U2" pin="3"/> 
    </net> 
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Struktur Berkas Netlist Umum
Berkas Netlist antara terdiri dari lima bagian.

Bagian header.

Bagian komponen.

Bagian lib parts.

Bagian pustaka.

Bagian net.

Isi berkas ini memiliki pembatas <export>

Bagian Header
Bagian header memiliki pembatas <design>

Bagian ini bisa dianggap sebagai bagian komentar.

Bagian Komponen
Bagian komponen memiliki pembatas <components>

Bagian ini berisi daftar komponen yang ada pada skematik Anda. Setiap komponen dijelaskan seperti ini:

<export version="D"> 
... 
</export>

<design> 
<source>F:\kicad_aux\netlist_test\netlist_test.sch</source> 
<date>21/08/2010 08:12:08</date> 
<tool>eeschema (2010-08-09 BZR 2439)-unstable</tool> 
</design>

<components> 
<comp ref="P1"> 
<value>CONN_4</value> 
<libsource lib="conn" part="CONN_4"/> 
<sheetpath names="/" tstamps="/"/> 
<tstamp>4C6E2141</tstamp> 
</comp> 
</components>
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libsource name of the lib where this component was found.

part component name inside this library.

sheetpath path of the sheet inside the hierarchy: identify the sheet within
the full schematic hierarchy.

tstamps (time stamps) time stamp of the schematic file.

tstamp (time stamp) time stamp of the component.

Catatan Mengenai Tanda Waktu Komponen
Untuk mengidentifikasi sebuah komponen di dalam Netlist dan kemudian di papan sirkuit, digunakan
referensi tanda waktu yang bersifat unik untuk setiap komponen. KiCad juga menyediakan cara lain untuk
mengidentifikasi sebuah komponen dengan footprint yang terkait di papan sirkuit. Dengan demikian, bisa
dilakukan anotasi ulang komponen-komponen pada proyek skematik, dan tautan antara komponen dan
footprint akan tetap terjaga.

Tanda waktu menjadi pengidentifikasi yang bersifat unik untuk setiap komponen atau lembar kerja pada
suatu proyek skematik. Namun di hirarki kompleks, satu lembar kerja yang sama bisa digunakan lebih dari
satu kali, sehingga lembar kerja ini akan berisi komponen-komponen dengan tanda waktu yang sama.

Lembar kerja tersebut memiliki sebuah pengidentifikasi unik di hirarki kompleks: path lembar kerja. Maka,
komponen (di dalam hirarki kompleks) memiliki pengidentifikasi unik berupa: path lembar kerja + tanda
waktu.

Bagian Libparts
Bagian libparts memiliki pembatas <libparts>, dan isi dari bagian ini didefinisikan di pustaka skematik.
Bagian ini berisi:

The allowed footprints names (names use wildcards) delimiter <fp>.

Pembatas <fields>, atribut-atribut yang didefinisikan di dalam pustaka.

Pembatas <pins>, daftar pin.

<comp ref="P1"> 
<value>CONN_4</value> 
<libsource lib="conn" part="CONN_4"/> 
<sheetpath names="/" tstamps="/"/> 
<tstamp>4C6E2141</tstamp> 
</comp>
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Baris seperti <pin num="1" type="passive"/> juga menampilkan tipe pin elektrikal. Tipe pin elektrikal yang
bisa digunakan antara lain:

Input Pin masukan biasa

Output Pin keluaran biasa

Bidirectional Masukan atau keluaran

Tri-state Bus masukan/keluaran

Passive Komponen pasif biasa

Unspecified Tipe elektrikal yang tidak diketahui

Power input Masukan power suatu komponen

Power output Keluaran power, seperti keluaran regulator

Open collector Open collector yang biasanya ada di komparator analog

Open emitter Open emitter yang terkadang ada di logika

Not connected Harus dibiarkan terbuka di skematik

Bagian Pustaka
Bagian pustaka memiliki pembatas <libraries>. Bagian ini berisi daftar pustaka skematik yang digunakan
pada proyek.

<libparts> 
<libpart lib="device" part="CP"> 
  <description>Condensateur polarise</description> 
  <footprints> 
    <fp>CP*</fp> 
    <fp>SM*</fp> 
  </footprints> 
  <fields> 
    <field name="Reference">C</field> 
    <field name="Valeur">CP</field> 
  </fields> 
  <pins> 
    <pin num="1" name="1" type="passive"/> 
    <pin num="2" name="2" type="passive"/> 
  </pins> 
</libpart> 
</libparts>
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Bagian Net
Bagian net memiliki pembatas <nets>. Bagian ini berisi "konektivitas" skematik.

Bagian ini menampilkan daftar semua net pada skematik.

Sebuah net bisa memiliki daftar seperti berikut ini.

net code Pengidentifikasi internal untuk net ini

name Nama net

node Referensi pin yang terhubung ke net ini

Lebih Lanjut Tentang xsltproc
Silakan mengacu pada halaman: http://xmlsoft.org/XSLT/xsltproc.html

<libraries> 
  <library logical="device"> 
    <uri>F:\kicad\share\library\device.lib</uri> 
  </library> 
  <library logical="conn"> 
    <uri>F:\kicad\share\library\conn.lib</uri> 
  </library> 
</libraries>

<nets> 
  <net code="1" name="GND"> 
    <node ref="U1" pin="7"/> 
    <node ref="C1" pin="2"/> 
    <node ref="U2" pin="7"/> 
    <node ref="P1" pin="4"/> 
  </net> 
  <net code="2" name="VCC"> 
    <node ref="R1" pin="1"/> 
    <node ref="U1" pin="14"/> 
    <node ref="U2" pin="4"/> 
    <node ref="U2" pin="1"/> 
    <node ref="U2" pin="14"/> 
    <node ref="P1" pin="1"/> 
  </net> 
</nets>

<net code="1" name="GND"> 
  <node ref="U1" pin="7"/> 
  <node ref="C1" pin="2"/> 
  <node ref="U2" pin="7"/> 
  <node ref="P1" pin="4"/> 
</net>

http://xmlsoft.org/XSLT/xsltproc.html
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Pengenalan
xsltproc adalah sebuah alat baris perintah untuk menerapkan stylesheet XSLT ke dokumen XML. Alat ini
dkembangkan sebagai bagian dari proyek GNOME, namun dapat digunakan secara independen di luar
desktop GNOME.

xsltproc dijalankan melalui baris perintah dengan nama stylesheet yang akan digunakan diikuti dengan
nama berkas yang mana stylesheet akan diterapkan. Alat ini akan menggunakan masukan standar jika nama
berkas yang diberikan berupa -.

Jika tersedia sebuah stylesheet di dalam dokumen XML dengan 'Style-sheet Processing Instruction', kita tidak
perlu lagi menyebutkan sebuah stylesheet pada baris perintah. xsltproc akan secara otomatis mendeteksi
stylesheet yang tersedia dan menggunakannya. Secara default, keluaran dari perintah ini adalah ke stdout.
Keluaran bisa disimpan ke sebuah berkas dengan menggunakan opsi -o.

Sinopsis

Opsi-opsi Baris Perintah
-V atau --version

Menampilkan versi libxml dan libxslt yang digunakan.

-v atau --verbose

Menampilkan setiap langkah yang diambil oleh xsltproc dalam memproses stylesheet dan dokumen.

-o atau --output file

Mengarahkan keluaran ke berkas dengan nama file. Untuk keluaran lebih dari satu, juga dikenal sebagai
"'chunking'", -o direktori/ akan mengarahkan berkas keluaran ke direktori yang ditentukan. Direktori
tersebut harus sudah ada sebelumnya.

--timing

Menampilkan waktu yang digunakan untuk menguraikan stylesheet, menguraikan dokumen, dan
menerapkan stylesheet dan menyimpan hasilnya. Ditampilkan dalam satuan milidetik.

--repeat

Menjalankan transformasi sebanyak 20 kali. Digunakan untuk pengujian pewaktuan.

--debug

Menghasilkan sebuah pohon XML dari dokumen yang ditransformasikan, untuk keperluan debugging.

xsltproc [[-V] | [-v] | [-o *file* ] | [--timing] | [--repeat] | 
[--debug] | [--novalid] | [--noout] | [--maxdepth *val* ] | [--html] | 
[--param *name* *value* ] | [--stringparam *name* *value* ] | [--nonet] | 
[--path *paths* ] | [--load-trace] | [--catalogs] | [--xinclude] | 
[--profile] | [--dumpextensions] | [--nowrite] | [--nomkdir] | 
[--writesubtree] | [--nodtdattr]] [ *stylesheet* ] [ *file1* ] [ *file2* ] 
[ *....* ]
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--novalid

Lewati memuat DTD dokumen.

--noout

Jangan mengeluarkan hasilnya.

--maxdepth value

Atur kedalaman maksimum dari tumpukan templat sebelum libxslt menyimpulkan bahwa ini adalah
putaran tak terbatas. Nilai default adalah 500.

--html

Dokumen masukan berupa berkas HTML.

--param name value

Memberikan parameter nama name dan nilai value ke stylesheet. Anda bisa memberikan beberapa pasang
nama/nilai hingga jumlah maksimum 32. Jika nilai yang diberikan berupa 'string' dan bukan 'node identifier',
gunakan --stringparam.

--stringparam name value

Memberikan parameter berupa nama name dan nilai value di mana value adalah 'string' dan bukan 'node
identifier'. (Catatan: 'string' harus utf-8.)

--nonet

Jangan menggunakan Internet untuk mengambil DTD, entitas atau dokumen.

--path paths

Menggunakan daftar (dipisahkan oleh spasi atau kolom) path sistem berkas untuk memuat DTD entitas atau
dokumen.

--load-trace

Menampilkan ke stderr semua dokumen yang dimuat selama pemrosesan.

--catalogs

Gunakan katalog SGML yang disebutkan di SGML_CATALOG_FILES untuk menyelesaikan lokasi entitas
eksternal. Secara default, xsltproc akan melihat katalog yang disebutkan di XML_CATALOG_FILES. Jika tidak
disebutkan di situ, maka digunakan /etc/xml/catalog.

--xinclude

Memproses dokumen masukan menggunakan spesifikasi Xinclude. Lebih lanjut mengenai hal ini bisa
ditemukan pada spesifikasi Xinclude: http://www.w3.org/TR/xinclude/

--profile --norman

http://www.w3.org/TR/xinclude/
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Menghasilkan keluaran berupa informasi profiling yang menjelaskan jumlah waktu yang dihabiskan dalam
setiap bagian stylesheet. Hal ini berguna untuk mengoptimasi performa stylesheet.

--dumpextensions

Mengeluarkan daftar semua ekstensi terdaftar ke stdout.

--nowrite

Jangan menulis ke berkas atau sumber apapun.

--nomkdir

Jangan membuat direktori.

--writesubtree path

Diperbolehkan menulis berkas hanya di dalam path.

--nodtdattr

Jangan menerapkan atribut default dari DTD dokumen.

Nilai Kembali Xsltproc
xsltproc akan mengembalikan sebuah nomor status yang akan berguna saat kita menjalankannya di dalam
sebuah skrip.

0: normal

1: tidak ada argumen

2: terlalu banyak parameter

3: opsi tidak diketahui

4: gagal mengurai stylesheet

5: terdapat kesalahan pada stylesheet

6: terdapat kesalahan pada salah satu dokumen

7: metode xsl:output tidak didukung

8: parameter 'string' berisi tanda petik dan tanda petik ganda

9: kesalahan pemrosesan internal

10: pemrosesan terhenti oleh suatu pesan penghentian

13: tidak dapat menulis hasil ke berkas keluaran

Informasi Lebih Lanjut Tentang xsltproc
Halaman web libxml: http://www.xmlsoft.org/

Halaman XSLT W3C: http://www.w3.org/TR/xslt

http://www.xmlsoft.org/
http://www.w3.org/TR/xslt


137

Simulator
KiCad provides an embedded electrical circuit simulator using ngspice as the simulation engine.

Ketika bekerja dengan simulator, Anda akan membutuhkan pustaka resmi pspice. Pustaka ini memiliki
simbol-simbol umum yang digunakan untuk simulasi seperti sumber tegangan/arus atau transistor dengan
pin yang penomorannya sesuai dengan spesifikasi urutan node ngspice.

Disediakan pula beberapa proyek demo untuk menunjukkan kemampuan simulator. Anda bisa
membukanya di direktori demos/simulation.

Menerapkan Model
Sebelum melakukan simulasi, kita harus menentukan model Spice untuk masing-masing komponen.

Setiap komponen hanya bisa mendapatkan satu model, meskipun komponen tersebut terdiri dari beberapa
bagian. Dalam hal ini, model Spice diterapkan pada bagian yang pertama.

Komponen-komponen pasif dengan referensi yang cocok dengan suatu tipe divais dalam notasi Spice (R*
untuk resistor, C* untuk kapasitor, L* untuk induktor) akan memiliki model yang diterapkan secara implisit
dan menggunakan atribut nilai untuk menentukan propertinya.

NOTE
Ingat bahwa di Spice, penggunaan 'M' berarti milli dan 'Meg' berarti mega. Jika Anda lebih
suka menggunakan 'M' untuk mengindikasikan mega, Anda bisa melakukan pengaturan di
kotak dialog pengaturan simulasi.

Informasi model Spice disimpan sebagai teks pada atribut-atribut simbol. Anda bisa mendefinisikannya di
Symbol Editor atau di Schematics Editor. Buka kotak dialog Symbol Properties dan klik pada tombol Edit
Spice Model untuk membuka dialog Spice Model Editor.

Kotak dialog 'Spice Model Editor' mempunyai tiga tab sesuai dengan tipe modelnya. Ada dua opsi umum
untuk semua tipe model:

http://ngspice.sourceforge.net/
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““

Disable symbol for
simulation

When checked the component is excluded from simulation.

Alternate node sequence Allows one to override symbol pin to model node mapping. To
define a different mapping, specify pin numbers in order
expected by the model.

'Example:' 

* connections:  

* 1: non-inverting input  

* 2: inverting input  

* 3: positive power supply  

* 4: negative power supply  

* 5: output  

.subckt tl071 1 2 3 4 5

To match the symbol pins to the Spice model nodes shown
above, one needs to use an alternate node sequence option with
value: "1 3 5 2 4". It is a list of pin numbers corresponding to the
Spice model nodes order.

Tab Passive
Di tab Passive, kita bisa menerapkan sebuah model divais pasif (resistor, kapasitor, atau induktor) ke suatu
komponen. Namun hal ini jarang digunakan, karena umumnya komponen pasif telah memiliki model yang
diterapkan secara implisit, kecuali jika referensi komponen tidak cocok dengan tipe divais aktual.

NOTE

Model divais pasif yang ditetapkan secara eksplisit memiliki prioritas lebih tinggi
daripada model divais yang ditetapkan secara implisit. Artinya, setelah model divais pasif
telah ditetapkan, atribut referensi dan nilai akan diabaikan selama simulasi. Hal ini
mungkin akan membingungkan ketika nilai model yang ditetapkan tidak sesuai dengan
nilai yang ditampilkan pada lembar kerja skematik.
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Type Memilih tipe divais (resistor, kapasitor, atau induktor).

Value Menentukan properti divais (resistansi, kapasitansi, atau
induktansi). Nilainya bisa menggunakan prefiks satuan Spice
(seperti ditampilkan di bawah kotak masukan teks) dan harus
menggunakan titik sebagai pemisah desimal. Ingat bahwa Spice
tidak bisa menginterpretasikan secara tepat prefiks yang
disilangkan dengan nilai (misalnya 1k5).
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Tab Model
Tab Model digunakan untuk menetapkan suatu semikonduktor atau model kompleks yang didefinisikan
pada sebuah berkas pustaka eksternal. Pustaka model Spice terkadang disediakan oleh manufaktur.

Kotak teks utama menampilkan isi berkas pustaka yang dipilih. Sudah menjadi praktik yang umum untuk
memasukkan penjelasan model ke dalam berkas pustaka, termasuk urutan node.
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File Path menuju ke berkas pustaka Spice. Berkas ini akan digunakan
oleh simulator, dan ditambahkan dengan direktif .include.

Model Model divais yang dipilih. Ketika ada sebuah berkas yang dipilih,
daftar ini akan diisi dengan model yang tersedia untuk dipilih.

Type Pilihan tipe model (subsirkuit, BJT, MOSFET atau dioda).
Normalnya, pilihan ini ditentukan secara otomatis ketika sebuah
model dipilih.

Tab Source
Tab Source digunakan untuk menetapkan model sumber sinyal atau power. Ada dua bagian: DC/AC analysis
dan Transient analysis. Masing-masing mendefinisikan parameter sumber untuk tipe simulasi yang terkait.

Opsi Source type diaplikasikan untuk semua tipe simulasi.
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Silakan mengacu ke dokumentasi ngspice, Bab 4 (Voltage and Current Sources) untuk informasi lebih lanjut.

Direktif Spice
Dimungkinkan untuk menambahkan direktif-direktif Spice dengan meletakkannya pada atribut teks di
lembar kerja skematik. Pendekatan ini mudah dilakukan untuk mendefinisikan tipe simulasi default. Fungsi
ini terbatas pada direktif Spice yang dimulai dengan tanda titik (misalnya ".tran 10n 1m"). Tidak
dimungkinkan untuk meletakkan komponen tambahan menggunakan atribut teks.

http://ngspice.sourceforge.net/docs/ngspice-27-manual.pdf
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Simulasi
Untuk menjalankan simulasi, buka kotak dialog Spice Simulator dengan memilih menu Tools → Simulator
pada jendela editor skematik.

Kotak dialog ini dibagi menjadi beberapa bagian:

Bilah alat

Panel Plot

Konsol keluaran

Daftar sinyal

Daftar kursor

Panel Tune

Menu

Menu File
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New Plot Membuat tab baru pada panel plot.

Open Workbook Membuka daftar sinyal yang di-plot.

Save Workbook Menyimpan daftar sinyal yang di-plot.

Save as image Mengekspor plot yang aktif ke berkas .png .

Save as .csv file Mengekspor data mentah titik-titik plot ke berkas .csv .

Exit Simulation Menutup kotak dialog.

Simulasi

Run Simulation Menjalankan simulasi menggunakan pengaturan saat ini.

Add signals… Membuka kotak dialog untuk memilih sinyal yang akan diplot.

Probe from schematics Menjalankan alat Probe skematik.

Tune component value Menjalankan alat Tuner.

Show SPICE Netlist… Membuka kotak dialog yang menampilkan Netlist yang telah
dibuat untuk sirkuit yang disimulasikan.

Settings… Membuka kotak dialog pengaturan simulasi.

Menu View

Zoom In Perbesar tampilan pada plot yang aktif.

Zoom Out Perkecil tampilan pada plot yang aktif.

Fit on Screen Mengatur tampilan untuk menampilkan semua plot.

Show grid Tampilkan/sembunyikan grid.

Show legend Tampilkan/sembunyikan legenda plot.

Bilah Alat

Bilah alat bagian atas digunakan untuk mengakses perintah-perintah yang sering dijalankan.
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Run/Stop Simulation Jalankan atau hentikan simulasi.

Add Signals Membuka kotak dialog untuk memilih sinyal yang akan di-plot.

Probe Menjalankan alat Probe skematik.

Tune Menjalankan alat Tuner.

Settings Membuka kotak dialog pengaturan simulasi.

Panel Plot
Memvisualisasikan hasil simulasi dalam bentuk plot. Kita bisa membuka beberapa plot pada tab yang
berbeda, namun ketika simulasi dijalankan, hanya tab yang aktif saja yang akan diperbarui. Dengan
demikian dimungkinkan untuk membandingkan hasil simulasi dengan parameter yang berbeda.

Plot dapat diatur dengan menampilkan/menyembunyikan grid dan legenda menggunakan menu View.
Ketika legenda ditampilkan, kita bisa menggeser untuk mengubah posisinya.

Interaksi panel plot:

Putar roda tetikus untuk memperbesar/memperkecil tampilan.

Klik-kanan untuk membuka menu konteks untuk mengatur tampilan.

Gambar sebuah kotak pemilih untuk memperbesar area yang dipilih.

Geser kursor untuk mengubah koordinatnya.

Konsol Keluaran
Konsol keluaran menampilkan pesan-pesan dari simulator. Kita perlu memeriksa konsol untuk memastikan
tidak ada pesan kesalahan dan peringatan.

Daftar Sinyal
Menampilkan daftar sinyal yang ditampilkan pada plot yang aktif.

Interaksi daftar sinyal:

Klik-kanan untuk membuka menu konteks untuk menyembunyikan sinyal atau mengubah kursor.

Klik-ganda untuk menyembunyikan sinyal.

Daftar Kursor
Menampilkan daftar kursor dan koordinatnya. Setiap sinyal bisa memiliki satu kursor yang ditampilkan.
Konfigurasi visibilitas kursor diatur menggunakan daftar Signals.

Panel Tune
Menampilkan komponen-komponen yang diambil menggunakan alat Tuner. Panel ini digunakan untuk
memodifikasi nilai komponen secara cepat dan mengamati pengaruhnya pada hasil simulasi - setiap kali
nilai sebuah komponen diubah, simulasi akan dijalankan ulang dan plot akan diperbarui.

Untuk setiap komponen, ada beberapa kendali yang terkait:
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Atribut teks top mengatur nilai maksimum komponen.

Atribut teks middle mengatur nilai aktual komponen.

Atribut teks bottom mengatur nilai minimum komponen.

Slider digunakan untuk mengubah nilai komponen secara halus.

Tombol Save memodifikasi nilai komponen pada skematik ke nilai yang dipilih dengan menggunakan
slider.

Tombol X menghapus komponen dari panel Tune dan mengembalikan ke nilai aslinya.

Ketiga atribut teks di atas mengenali prefiks satuan Spice.

Alat Tuner
Alat Tuner digunakan untuk memilih komponen untuk keperluan tuning.

Untuk memilih komponen untuk tuning, klik pada satu komponen di editor skematik ketika alat ini aktif.
Komponen yang dipilih akan muncul di panel Tune. Kita hanya bisa melakukan tuning komponen pasif.

Alat Probe
Alat Probe digunakan untuk memilih sinyal untuk dilakukan plotting.

Untuk menambahkan sinyal yang akan diplot, klik pada wire yang diinginkan di editor skematik ketika alat
ini aktif.
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Pengaturan Simulasi

Kotak dialog pengaturan simulasi digunakan untuk mengatur tipe dan parameter-parameter simulasi. Ada
empat tab pada kotak dialog ini:

Tab AC

Tab DC Transfer

Tab Transient

Tab Custom

Tiga tab pertama digunakan untuk memasukan parameter-parameter simulasi. Tab yang terakhir digunakan
untuk menuliskan direktif kustom Spice untuk membuat sebuah simulasi. Untuk informasi lebih lanjut
mengenai tipe dan parameter-parameter simulasi, lihat dokumentasi ngspice, Bab 1.2.

Cara lain untuk mengkonfigurasi sebuah simulasi adalah dengan menuliskan direktif Spice ke atribut teks
pada skematik. Setiap direktif atribut teks yang berhubungan dengan tipe simulasi akan ditimpa dengan

http://ngspice.sourceforge.net/docs/ngspice-27-manual.pdf
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pengaturan yang dipilih pada kotak dialog. Hal ini berarti bahwa setelah Anda menggunakan kotak dialog
simulasi, kotak dialog akan menimpa direktif-direktif skematik hingga simulator dibuka kembali.

Ada dua opsi yang umum untuk semua tipe simulasi:

Adjust passive symbol
values

Mengganti nilai simbol pasif untuk mengkonversi notasi nilai
komponen umum ke notasi Spice.

Add full path for .include
library directives

Menambahkan nama berkas pustaka model Spice dengan path
lengkap. Normalnya, ngspice memerlukan path lengkap untuk
mengakses sebuah berkas pustaka.
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